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1 Get started 

 

  

Here is how to proceed:  

1) Install Banana Accounting 

2) Enter the license key that has been sent to you by email upon purchase 

3) Open the Banana Accounting software and choose the New command from the 

File menu 

4) Choose the accounting type 

5) Choose an example or template according to your needs 

6) Adapt your accounting plan (Double-entry accounting) or the Category and Account 

tables (Cash book and Simple accounting) 

7) Setup the VAT table and the Exchange rates table (if you chose the VAT or Multi-

currency options)  

8) Start entering transactions 

 

1.1 Install Banana Accounting 

Banana Accounting automatically installs in a matter of minutes. If you download the file from our website, 

you just need to double-click on the file you downloaded; otherwise, you just insert the installation CD. These 

windows will pop up automatically: 
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By clicking on the "Next" button, you will be carried to the next window until the installation process is 

finished. 

 The installation does not modify any system file or directory 

 It is not necessary to Restart the computer after the installation 

 An uninstaller software is also included in the installation 

Open the software 

 

  



9 

B A N A N A  A C C O U N T I N G  

 

  

As soon as you open the software, choose the New command from the File menu. From the pop-up 

window you will be able to choose your accounting type, the option with or without VAT, the file language, 

and an example or prototype (or you can also open a blank file - not recommended) 

1.2 Insert the license key 

By inserting the license key into Banana Accounting, you go from the demo mode to the complete mode. 

You'll find the license key on the yellow flyer that is being furnished together with the CD or it is being sent by 

email (for purchases online). Here is how to proceed: 

 Open Banana Accounting. 

In Windows XP, with the right key of the mouse, click on the icon of the Banana application (Banana 

6.exe), click on "Execute as" and activate "The next user", and select the administrator. 

In Windows Vista, with the right key of the mouse, click on the icon of the Banana application 

(Banana 6.exe), click on "Execute as administrator". 

In case these steps are not followed, the following error message will appear: "The license key 

cannot be memorized". 
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 Select the "Insert license key" command of the "?" menu. 

 

.   

 Transcribe the license key in the appropriate box 

 
.    

If the license key is not inserted, a message appears at the opening of the accounting file, warning the user 

that he is working in demo mode. 
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IMPORTANT 

Keep the license key, found on the yellow flyer together with the CD or sent by email. 

 

1.2.1 Lost license key 

You can ask us - by email - to resend you your own license key. For us to be able to find it, please send us 

the registration key displayed in the window License key info (Insert license key command) of the 

Help menu. You may also send us a screenshot of that same window. 

  

Please note: Sending you your license key costs 20.- Chf. 

If the registration key cannot be provided, but only a proof of purchase, the costs will be 30.- Chf. 

If it is impossible to provide the registration key and/or a proof of purchase, a new license needs to be 

purchased. 

 

1.3 Installing on Mac and Linux 

Banana accounting 6, with the help of Windows emulator software, can be installed on Mac and Linux: 

 Installing on Mac 

 Installing on Linux 

1.4 Installing on a server 

If you need to install Banana Accounting on a server (citrix or even more) the procedure is simple because 

Banana does not need special components or specific settings for a user.  

To install on your server proceed as follows:  

 Follow the normal installation procedure on a local disk.  

 Enter the license key.  

 Copy the directory C \ Program Files \ BananaXX \ (XX stands for the version number) on the 

network drive.  

 You must then create the connection with the program BananaXX.exe so that users of the local 

computer can run the program.  

 

Remember that in order to execute Banana Accounting from multiple computers, you need to buy as many 

licenses as there are computers that use the program. 
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2 Characteristics 

The Banana Accounting software is one of the most used accounting software in Switzerland, and it is 

constantly expanding worldwide, almost exclusively thanks to the spread word of satisfied users. 

  

 

 

 

  

Choose the application that suits you best.  For each one of them (Cash Book, Simple 

Accounting, Double-Entry Accounting, Multi-currenciy accounting), there are pre-set accounting 

plan templates. 

 

  Choose the option with or without VAT/Sales tax management 

 

  

Choose the desided language and country. For each country the program includes pre-set 

accounting plans, some of them with transactions examples. By selecting a specific country you 

can access directly the accounting plans for the selected country. 

 

  

Choose the template or the example that best suits your needs. On our web site, in the Users 

profile section, you can download for free more accounting plans. Just double click on the 

accounting plan you wish to download and save it. All accounting plan templates and examples 

can be personalized. 

  

Banana Accounting Tour  for a Double-Entry Accounting (Video) 

Banana Accounting Tour for a Simple Accounting (Video) 

  

Good to know... 

File 

Each accounting is a separate file - it is possible to manage infinite files - in each file it is possible to enter an 

unlimited number of  transactions, to change the commands language, the decimals rounding, and to choose 

the option with or without VAT. 

http://www.banana.ch/cms/files/resources/intro_doppia_en.html
http://www.banana.ch/cms/files/resources/intro_semplice_en.html
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Language/s 

The software can be installed in one or several languages. In the multi-lingual version, it is possible to switch 

from one to the other with a simple command. It is possible to open files in different languages. The software 

includes, for each language and nation, different pre-set accounting plans and transactions examples. 

Interface 

The software interface is very similar to Excel, structured in tables. The use is very intuitive. To edit texts, 

you just need to position the mouse in the cell and rewrite (just like Excel). Each table has different Views, 

and each View has different Columns (they can vary from one View to the other). 

Results 

Amounts are automatically added after entering each transaction, and the balances are instantly updated. 

Results are immediate: 

 Account cards with opening balance, transactions and final balances 

 Account cards by period 

 Journal, even by period 

 Calculations and VAT reports 

 Statements 

 Balance sheets 

 Budgets 

 Cost centers 

 Clients/Suppliers Registers 

 Data export in Excel, Xml, Html formats 

 Data import from post or bank account statement 

 Data protection guaranteed with the Block and Password features 

Security 

The software does not contain viruses, malware or adware 

It does not include any advertising messages. 

When connecting to the www.banana.ch website, the software only downloads updates and news, but there 

is absolutely no access to users data. 

. 

  

http://www.banana.ch/
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2.1 System requirements 

  

Banana Accounting 6 

 Operating system Windows 2003/ XP / 2008 / Vista / Windows 7 

 15 MB disk space 

 Windows compatible printer 
 

Banana accounting 6 for Mac 

Banana accounting 6 for Mac includes: 

 License for Banana accounting 6 

 License for Crossover Mac Professional (Windows emulator) 

In order to install Banana accounting 6 on Mac, it is necessary to have CrossOver installed. 

Warning: Crossover Mac works only on Intel x86 CPU and Intel Core i3/i5/i7 systems. CrossOver doesn't 

work on PowerPC Mac G3, G4, G5 systems. Before buying Banana Accounting for Mac, please 

consult the page CrossOver Mac System requirements. 

Crossover is compatible with the Sandy-Bridge Intel processors. 

  

Banana Accounting 5 

 Operating system Windows 2000 / 2003 / XP /NT / Vista / Windows 7      

 9 MB disk space 

 Windows compatible printer  

  

2.1.1 Banana for Mac (Intel) 

Banana 7 for Mac 

Starting with version 7,  Banana Accounting will be a native Mac application. 

  

Banana 6 per Mac  

Banana Accounting version 6 is no longer available as a bundle together with CrossOver. 

It is possible to use a Windows emulator, but support is not guaranteed. 

 

  

  

  

http://www.codeweavers.com/products/cxmac/requirements/
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2.1.2 Compatibility with Linux 

Now you can also use Banana Accounting on Linux 

Thanks to the Wine software, Banana can also be used with a Linux operational system, without losing the 

functionality of Windows.  

Wine is a free program that allows Windows applications to work on other operational systems.  

Hereunder is an image of Banana, working on Linux.       

  

 

  

  

Installation of Wine on Ubuntu Linux 

If you have not yet installed Wine, follow this procedure:  

 Go to “System”, “Administration” and select “Synaptic package manager"  

 Insert the user password 

 Look for Wine in the list 

 Select Wine, click with the mouse right-click and select the “Mark for installation” command 

 Select “Apply" 

 Click on "Apply"  

http://www.winehq.org/
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Installation of Banana using Wine  

At the end of the installation of Wine, download the software from the Banana Accounting site, launch the 

file and proceed with the installation as usual.  
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2.2 Interface 

When a new file is being created or an existing one is opened, the software presents a structure that is 

characterized by the following elements 

 
 

Menubar 

Commands grouped together by menu are contained in the menubar. The menubar changes according to 

the accounting setup selected.  

 

 

Toolbar 

The toolbar grants rapid access to the most frequently used windows and commands. 

Simply move the mouse to the desired icon and wait a second to get a description of its meaning. 

 

 

Text input area 

The text input area is situated right below the toolbar. Text must be inserted in this area. 

To edit an existing cell, click with the mouse on the area and proceed to edit, or hit the F2 key. 

If the smart fill function is enabled (Program options command, from the Tools menu), a list of texts and 

values shows up in the text input area on the upper part of the screen and, by hitting the arrow down key, the 

user can immediately select the needed text or value, without having to type the whole text. Confirm with 

Enter or F6. 
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Tables 

Each accounting file is made up of many tables. There are main and auxiliary tables. The tables vary 

according to the kind of accounting selected. 

 

 

In order to move from one table to another, click on the name of the desired table or use the Ctrl+PgUp and 

Ctrl+PgDn keys. 

  

Columns 

These are the vertical elements on each table. Their arrangement can be personalized. The column headers 

also vary according to the type of accounting selected. 

 

 

In order to view the entire heading of each column (on two lines), double click on the first top left cell. 

 

 
 

Views 

Each table can have more than one view, positioned on the bar at the bottom. The Views represent various 

ways of visualizing the fields of a table. 

The Views are very useful when it is necessary to see the accounting data in a different way (adding or 

deleting columns for example), without altering the basic set up. The user can move from one view to 

another with a simple click of the mouse on the name of the desired view. 

 

 
 

Information window 

This is a window without a title, positioned in the lower part of the screen, where useful information about the 

table or the active cell be found. It is also used to signal error messages in red. 
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Note: through the Program options command, from the Tools menu, the number of rows shown in the 

information window can be edited 

Error messages window 

The messages window contains a list of errors that the software has signaled.  

There are two ways to recall the error messages list: 

 Click on the Message Window command from the Window menu 

 Click on the Information icon from the Toolbar  

From the Message Window, by double-clicking on an error row, the cursor returns to the table and the row 

where the error was generated. 

2.3 Program options 

The program options contain software technical options. To access them, choose the Program options 

command from the Tools menu. 

  

 
  

Program language 

The Program Language is the language used by the program. Use this drop-down menu to select a 

language if the user wants to use a language different from the default or if the default is not available. 

Font type 

This drop-down menu allows the user to select the desired font. If the selected printer doesn’t print all the 

fonts, change the font with this menu. 

Zoom % 

If the user wants the data on the table to be shown in another size, adjust the percentage of Zoom here. 
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Height of info-window (in rows) 

Insert the number of rows to be shown in the Information window. As soon as the number of rows has been 

changed, the height of the Information window is automatically adapted. 

Smart fill rows limit 

When inserting data, the program reads the data that has already been entered and tries to suggest how to 

complete an entry. In cases where there are many rows, this function could slow down the process. 

The user can define a limit for the number of rows, above which the smart fill will not be used. If there is no 

value entered or zero, smart fill will always be used. 

Maximum number of undo operations 

Insert the maximum number of undo operations (one at a time) when using the Undo command from the Edit 

menu. 

Autosave (in minutes) 

This option allows saving the file automatically according to the desired frequency (in minutes). The program 

saves the data in a file called auto backup + file name. If the program or the computer crashes, the data can 

be recuperated by opening this file and saving it with a name (Save as…) from the File menu. 

Create backup copy (.bak) 

When the user saves to disk using the same name, the version of the file that already existed is renamed 

with a .BAK extension. 

Document Directory 

This is where the user inputs the name of the path (directory) in which the new files will be saved. 

Add up during selection 

By activating this cell, the program will add up the selected amounts. Deactivate this function if this 

instantaneous addition slows certain operations down. 

Show recently used files 

In the File menu, all the most recently used files are listed. 

Caret always on 

The Caret is an indicator of the position of the mouse. It is generally used by programs that facilitate activity 

for the blind or partially blind. 

Check for updates 

This option establishes a connection to the www.banana.ch website and checks if there is an update 

compared to the version that is used. 

Download news 

By activating this option, the latest news items appear on the start page. 

Double click action 

The double click action can be associated to one of the following two fonctions: 

 Open account card - in this case, an account card or a selection can be opened with a double click  

 Edit text - in this case, the text editing mode is activated by a double click, while the Account 

cards command (Account1 menu) needs to be used in order to open an account card.  

Extensions of files considered secure 

This option defines the file types that the software consents to open with a double click on the DocLink 

column of the Transactions table. This prevents from opening non-secure files by the program. 

Associate “.ac2” files to this program 

This function indicates to the operational system that the .ac2 files should be opened through this program. 

  

http://www.banana.ch/
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2.4 What's new in Banana 6 

Banana Accounting 6 is an improved version of Banana 5. The way Banana 6 is being used is identical to 

the use of Banana 5. We have succeeded to simplify commands and added several new ones, destined for 

our most demanding users. 

 Banana 5 and 6 files are completely interchangeable. Files saved with Banana 6 can also be opened 

with Banana 5.  

The most important novelties: 

 Text input with drop down menu from which the account numbers can be chosen and with the 

possibility to indicate or search a text.  

 Enhanced Balance sheet by groups with different styles 

 Enhanced Balance sheet with period subdivision 

The Balance sheet and the Profit/Loss statement can be printed with different layouts.   

Several reports can be created with different printing options.  

 End-of-year printouts in PDF format 

The different printouts (accounts, transactions, balance sheet, account cards, etc.) can be printed in 

a single PDF file (for Adobe Acrobat Reader). 

 All printouts can be seen as a a Preview, can be saved in PDF, Html, Excel, or copied to the 

Clipboard.  

 Segments - allow the user to obtain the Profit/Loss statement subdivided by departments, branch 

offices, sales departments, etc.  

 Create file copy - with the possibility to indicate, if the user wishes to do so, to keep only the chart of 

accounts, the transactions, etc.  

 Rename account, groupe, VAT code with an immediate update of the transactions. 

Other improvements: 

 Smart fill in all the text input areas. 

 Dialogue windows and buttons have a more modern outlook.  

 The information window can be resized with the mouse.  

 Possibility to exclude a column from printing.  

 Improved import feature for accounts or VAT codes, allowing a better synchronisation of the 

accounts in the Accounts table or the VAT codes in the VAT codes table.  

 Automatic VAT account in the File and Accounting properties; it is no longer needed to enter it 

manually in the VAT codes table.  

 

 New import formats for e-banking bank statements. 

Manual in PDF format: 

 The installer program copies the manual in Pdf format on the computer. Like this, you can browse 

and print the manual directly on your computer.  

 The box for sale in the shops is of a smaller size, adapted to the new standard format in use by the 

great distribution chains and has a reduced impact on the environment. It is not possible to include a 

full and exhaustive manual in this type of box. We have therefore decided to not print the manual 

and, giving preference to the Pdf version.  

What is not visible: 
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Simplifying things requires more work than complicating them. We have invested much time to keep the 

program simple and linear. 

Who uses Banana 6 can find out how easily and flexible the Balance sheet and the Profit/Loss statement 

can be created. In the same way, the simplicity in creating a Pdf file that contains all the printouts will not go 

unnoticed. 

We have created a printing engine, unique in its kind, that offers a considerable flexibility. Banana 

Accounting 6 required 4 years of development, as we wanted to create a technological platform that allows 

further developments and that guarantees the continuity of the product in the future. 

 

2.4.1 Transition from version 5 to version 6 

Banana Accounting 6, substantially remains the same as Banana Accounting 5. 

 Files from Banana Accounting 5 and Banana Accounting 6 are completely interchangeable. Files 

saved with Banana 6 can also be opened with Banana 5.  

 Banana 5 users wishing to modify files saved with Banana 6 must update their Banana 5 to the 

5.012 version.  

Changes in Banana Accounting 6: 

 Banana 6 does not allow to enter blank spaces as account numbers (for ex. 1000 Cash).  

If you open a Banana 5 file containing blank spaces in the accounts, you can eliminate them as 

follows:  

o Position your mouse in the Accounts Table, Accounts Column 

o Select all the Account Column and use the Copy and Paste commands from the Edit menu.  

o The same operation goes for the Transactions Table in the Debit and Credit columns. 

 The reports settings are independents for each version.  

If you have some settings on the version 5, these would not affect the version 6 settings and vice 

versa. 

 The new command Accounting reports groups the following features in only one command: 

Balances by period, Balances by Classes, External accounting report. 

2.5 Start Page 

The Start Page of Banana Accounting is has been part of the program from on version 5.010, conceived to 

offer the user an added instrument to accelerate the work. 

Thanks to the new start page, you can choose directly in which accounting you want to work and you have 

immediate access to useful information that is available on our website. In the presence of an active internet 

connection, in fact, the start page connects itself to the www.banana.ch website, in order to download and 

display automatically News items, advice and technical resources, and the availability of new updates. The 

program does not transmit nor read any personal data. From the start page, there is also a direct access to 

the last used files. 

The internet connection can be deactivated by choosing the Program options command from the Tools 

menu, then deactivating the Download news option. 

  

http://www.banana.ch/
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In order to manually check for the availability of a newer version than your own, launch the Check for 

updates command in the Help menu. 

  

 

 

2.6 Choose your own accounting 

To create your own accounting, you can choose from the following options: 

Cash book 

It is the ideal tool to 

manage the receipts 

and expenses of one 

single account (for 

example, cash, 

current bank or postal 

account, or other). 

Perfect to manage a 

household 

accounting or 

individual projects 

(associations, 

  

Simple accounting 

The Simple 

accounting is ideal for 

small businesses and 

associations. It is 

similar to the Cash 

book, but much more 

flexible, because it 

allows the user to 

manage the receipts 

and expenses of 

several accounts and 

with a professional 

  

Double-entry 

accounting 

The professional 

instrument to manage 

assets, liabilities, 

expenses and income 

according to the 

international rules of 

the Double-entry 

(debit and credit). 

Charts of accounts 

that can be 

customized, 

  Multi-currency accounting 

Multi-currency, multi-

company, multilingual. All 

this and many other 

features make this 

application perfect for 

international companies. 

Also used by professional 

accountants and accounting 

schools. Multi-currency 

accounting is based on the 

Double-entry accounting 

method and manages 
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companies). 

Available with or 

without VAT 

management. 

More info ... 

final statement. With 

or without VAT 

management. 

More info ... 

VAT/sales tax 

options, data import 

and export are only a 

few of the 

numerous functions.     

More info ... 

accounts in foreign 

currency.  

More info ... 

The following are some guidelines for the criteria to make the best choice: 

  

Minimum personal requirements Cash 

Book 

Single-

entry 

accounting 

Double-

entry 

accounting 

Multi- 

currency 

Basic user knowledge of a PC 
    

Little or no accounting knowledge 
  

    

Knowledge of the minimum accounting concepts, such as: 
Debit, Credit, Assets, Liabilities, Income, Expenses 

    
  

Knowledge of accounting concepts and specific features for 
managing foreign currencies 

      
 

 

  

Type of use Cash 

Book 

Single-

entry 

accounting 

Double-

entry 

accounting 

Multi 

currency 

Income and Expenses in an account 
 

      

Cash management in an office 
 

      

Management of a building loan 
 

      

Private accounting without accounts management 
 

      

Private accounting with accounts management   
 

    

Accounting for an association   
  

  

Accounting for an association with an obligation to draw up a 
balance sheet or to be recorded in the Companies Registry 

    
 

  

Accounting of a condominium   
  

  

Accounting for freelance professionals   
  

  

Accounting for shops and restaurant owners   
  

  

Small businesses not recorded in the Companies Registry   
  

  

Companies recorded in the Companies Registry     
 

  

Accounting with accounts management and transactions in 
several currencies 
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Functionality Cash 

Book 

Single-

entry 

accounting 

Double-

entry 

accounting 

Multi 

currency 

Internationally recognized method     
  

Transactions and accounts in several currencies       
 

Separation between income and expenses categories 
    

Management of several accounts   
   

Entry from one account to another   
   

Splitting-up of a payment over several expense categories 
    

Accounts or categories cards 
    

Transactions ledger  
    

Cost and Profit Centers 
    

VAT management and summaries 
    

Summary statements 
  

    

Balance Sheet and Profit and Loss Statement     
  

Calculation of exchange rate differences       
 

  

  

Tests 

Tests can be conducted using existing models.  

Conversion from one type to another 

Banana offers a command that allows a file of a certain type to be converted into a file of another type. The 

software automatically adapts the chart of accounts and entries. 

Help 

To ensure compliance with tax requirements, you can also obtain assistance from your own accountant/tax 

consultant for the following: 

 Choosing the type of accounting 

 Defining the accounting set-up 

 Making the first entries 

 Verifying the entries made 

 Closing the accounting year 

An effective collaboration method is to exchange accounting files by e-mail. Your accountant/tax consultant 

can check the accounts and make all the changes that may be required. After completing the check to 

ensure everything is correct, your accountant/tax consultant can send back the file to you and you can print 

out the results or continue making entries. 
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3 Documentation 

3.1 Basic operations 

The basic set-up (language, decimals, rounding system, ...) is normally decided when the accounting file is 

created. It can however be edited and modified anytime through simple commands.  

We here illustrate the main operations that simplify the user's work when there is the need of editing, moving, 

copying, renaming the accounting file or some of its contents. 

 

3.1.1 Adding and deleting an account 

Adding a new account 

In order to add a new account: 

 Position yourself in row above the one where you want to add the new account; add a new empty 

row with the command Add rows from the Edit menu (consult the lesson). 

 In the columns, insert the account number, the description, the BClass (1 for the Assets, 2 

for the Liabilities, 3 for the Expenses and 4 for the Revenue), and the Gr which needs to be the 

same as the one inserted for the accounts belonging to the same Group.. 

 Recheck the acccounting with the Shift + F9 key, or the Recheck accounting command from the 

Account1 menu. 

In the following example, we have added a new account 3150 Consultancies: 
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Deleting an account 

In order to delete an account: 

 Position yourself on the row number that contains the account that is to be deleted 

 From the Edit menu, click on the Delete rows command 

 Recheck the acccounting with the Shift + F9 key, or the Recheck accounting command from the 

Account1 menu. 
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In the example we have eliminated row 80, to eliminate the account 3240 Fees 
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3.1.2 Adding and deleting rows 

To insert blank rows below the selected row, follow these steps: 

 Move the cursor above the row where additional rows need to be inserted  

 From the Edit menu, select the Add rows command 

 In the window that appears, key in the number of rows to insert 

 Confirm by clicking on OK 

  

There is still another procedure to add blank rows: 

 Move the cursor above the row where additional rows need to be inserted 

 Click on the following icon  on the Tool bar, one time for each row that you want to add. This 

procedure is advised when the amount of rows to be added is rather limited. The sequence for 

the shortcut key is: Ctrl+Enter. 

  

To insert blank rows above the selected row, follow these steps: 

 Move the cursor below the row where additional rows need to be inserted 

 From the Edit menu, select the Insert rows command 

 In the window that appears, key in the number of rows to insert 

 Confirm by clicking on OK. 

In order to delete one or more rows, select the row or rows that need to be deleted and from the "Edit menu", 

click on the Delete rows command. 
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3.1.3 Changing accounting type 

It may occur that, during the year, it becomes necessary to change from one accounting type to another (for 

example passing from a simple accounting to a double-entry accounting or from a double-entry accounting to 

a double-entry accounting with VAT management). Here is how to proceed: 

 from the Tools menu choose the Convert to new file... command  

 from the pop up window that appears, choose the file type you wish to create  

 

 By pressing on the OK button a second pop-up window appears when you can choose the language 

and the rounding system of the new file 

 By pressing on the OK button a new file will be created, identical to the original (accounting plan, 

transactions, etc.) but with the new setup you just entered.  

 Save the new file with a name. 

Note: when converting a more complex accounting file into a simpler accounting type, some data loss may 

occur. We strongly suggest NOT to save the new file overwriting the old one.  

 

3.1.4 Changing the file language 

When a file is being created, the user is being asked to enter some basic information. The language is part 

of this basic information. 

If, on the contrary, the user wants to change the language of an already created file, proceed as follows:  

 From the Tools menu, choose the Convert to new file... command 

 In the window that opens, choose the type of file to create (if we only want to change the language, 

choose the same accounting type as the existing file) 

 By conforming with OK, a second window opens 

 In the section Language, enter the desired language. 
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 By confirming with OK, a file, identical to the original one (chart of accounts, transactions, 

VAT/Sales tax codes), is being created, with the new configurations that you have entered (in this 

case, the change of language) 

 Save the new file under a new name.  

3.1.5 Changing the program language 

In order to change the language of Banana Accounting, proceed as follows: 

 From the Tools menu, choose the "Program Options" command 

 In the window that appears, change the language in the Program language section 

 

  

For more information on this window, go the the Program Options page. 

 

  



32 

B A N A N A  A C C O U N T I N G   

3.1.6 Copy and Paste 

Copy and Paste - Ctrl+C and Ctrl+V  

It is possible to copy/paste cells, rows or selected text just as it is possible to do with any normal Windows 

program:  

 Select the line or the area of data to be copied 

 In the Edit menu, select the Copy command 

 Move to the row or the area where the information should be copied 

 From the Edit menu, select Paste  

The user can also copy/paste by using the following icons  or press Ctrl+C to copy and Ctrl+V to 

paste. 

3.1.7 Create file copy 

This command (Tools menu) creates a copy of the file with the possibility to select the indicated options in 

the window that appears: 

  

 

 

3.1.8 Customizing the views 

The views can be customized, with regard to the way the columns are shown, as well as modified where it 

concerns the number of views. 

In the first case the desired columns can be inserted or cancelled, even if they appear in other views, 

through the Set up fields command in the "Data" menu.  

In the second case, if a view is not needed and the user doesn't want it to be shown, it is possible to make it 

invisible through the Select field view command in the "Data" menu.  

New views can also be added, but only for information, according to the data entered by the user and they 

are not processed by the software.  
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3.1.9 Edit date, hour and number format 

When the format is modified, the way the date, time and numbers are shown, changes.  

If no specific format is specified, the default Windows format will be used (date, time and numbers indicated 

on the control panel). 

In the Format area of the Set up fields/Edit attributes command    (Data menu) the user can use other 

formats. Types of formats, with some examples, are listed below: 

 

Format date Examples for date 

d mm yy 1 01 07 

dd m yy 01 1 07 

ddd mmm yyyy Fri Jan 2007 

dddd mmmm yyyy Friday January 2007 

The letter “d” (day) indicates the day, the “m” (month) indicates the month, 

and the “y” (year) indicates the year. 

Format time Examples for time 

hh:mm:ss:iii  04:04:36:089 

h:m:ss:ii  4:4:36:89 

Naturally the user can also invert the order of the elements making up the 

date or the time as desired (e.g.: mm dd yyyy). 

As far as the separators are concerned, the user can choose between all of 

those available on the keyboard (for example: #, @, -, /, ., etc.). 

Format numbers Example for numbers 

0.  259 

0.00  258.85 

0.000  258.848 

The number of decimal spaces in a number field can be edited according to 

the user’s needs. Actual calculations are made using all the inserted decimal 

numbers. Rounding is only done for what is shown on screen.  

  

3.1.10 Editing an account or a VAT code 

This command allows the user to change the account or category number (accounts or categories table) and 

the VAT code (VAT Codes table), without having to enter the necessary modifications in the transactions. 
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The Rename is available in the "Data" menu. 

In order to rename, the user has to: 

 Position himself with the mouse on the cell that has to be changed (account/category number, VAT 

code) 

 Click on the Rename command in the Data menu.  

 Enter the modification in the window that appears. 

The software inserts the new modifications, connected to the Rename operation, automatically in the 

Transactions table. 

 

3.1.11 Editing columns display 

In every view, the columns can be personalized: it is possible to display those that were not visible and to 

make invisible those that are being displayed.  

To edit the columns, click on the "Data" menu and activate the Set up fields command. The following 

window, from which the desired operations can be executed, appears:   

  

   

 Eliminating the display of a column: in the window that appears, select the column that has 

to be deactivated, then double click on it or press the button "Edit attributes". A detailed window for 

the column appears, in which the option "Visible" has to be deactivated. Confirm with "OK". You can 

also access the detailed window of the column directly from the table in which you are working, by 

double clicking on the column header.  
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 Displaying an invisible column: from the "Data" menu, activate the Set up fields command 

and select the column to be activated, then double click on it or press the button "Edit attributes". A 

detailed window for the column appears, in which the option "Visible" has to be activated, down at 

the left side. Confirm with OK. 
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Note: with the "Move up" and "Move down" buttons, it is possible to move the columns in the desired order.   

  

 

 

3.1.12 Editing the columns 

To edit the columns, follow these steps:  

 Double click on the header of the column that has to be edited 

 In the information window "Display columns" that appears, change the parameters of your choice: 

header, description, width, alignment, etc.  
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You can also access the "Display columns" window from the "Data" menu, Set up fields command, then 

double click on the name of the column.   

To widen and reduce the width of a column, you can also place yourself with the mouse on the edge 

of a column (header cell), keep the left mouse button pressed and move to the right in order to widen the 

column and to the left in order to reduce the width of the column.  

 

3.1.13 Editing the default style 

For the whole file, there is a default style. When a new row is being added, the default style is being used. 

How to change the default style: 

 Assign the desired style to a row 

 Choose the command This style as default from the Format menu  

All the rows with the default style are being displayed with the newly chosen style.   

 

3.1.14 Modifying the rounding of the decimal points 

When a file is being created, the user is being asked to enter some basic information. The rounding of the 

decimal points is part of this basic information. 

If, on the contrary, the user wants to change the rouding system of an already created file, proceed as 

follows:   

 From the Tools menu, choose the Convert to new file... command 

 In the window that opens, choose the type of file to create (if we only want to change the type of 

rounding for the decimal points, choose the same accounting type as the existing file) 

 By conforming with OK, a second window opens 
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 In the section Decimal points for amounts or Rounding type, enter the desired 

modifications. 

 

 By confirming with OK, a file, identical to the original one (chart of accounts, transactions, 

VAT/Sales tax codes), is being created, with the new configurations that you have entered (in this 

case, the rounding of the decimal points) 

 Save the new file under a new name.  

3.1.15 Page break  

At any point in a file, the user can insert a page break 

  

To insert a page break: 

 Place the cursor on the first row where the new page is to be created 

 Open the Format menu 

 Select the Page break command 

To remove a page break: 

 Place the cursor on the row with the page break 

 Open the Format menu  

 Disactivate the Page break command  

3.1.16 Recurring transactions 

How to speed up the introduction of data when similar or exactly the same operations 

occur every month  

Method 1 – when the beginning of a text is inserted, the program indicates in the information window at the 

top of the screen, all of the texts inserted before, by means of the "Smart fill" feature. Select the desired text 

to be inserted and press the F6 key. The program automatically inserts all the earlier inserted data of the 

similar line. Eventually change the amount if it is not identical to the old amount. 

Attention: in order to deactivate the smart fill of the preceeding year, the function "Smart fill with transactions 

from previous year" (File menu, File and Accounting properties command) must be deactivated. 
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Method 2 – copy or create the repetitive transactions in the Memorized text table (Cash2, Simple2, 

Account2 menu - Recurring transations) inserting initials or an identification code in the “Doc” column.  

In the Transactions table, after having inserted the data, insert the initials or identification code for the 

memorized text in the “Doc” column and press the F6 key. The program automatically inserts all the 

transactions of the memorized rows.  

 

3.1.17 Shortcut keys 

There are many options that are specifically created to work rapidly. We indicate hereunder the ones most 

frequently used: 

Copy from above – F4 key 

When starting an empty entry row, this key will copy the content of the preceding line. The function can also 

be activated from the Edit menu or by hitting the following icon  .  

Execute command– F6 key 

While inputting transactions, this key will increase the date automatically according to the date in the 

previous cell. 

Add line+transaction – Shift+F6 keys 

This option allows the user to add a new row and pick up the transaction from the preceding line, all at the 

same time. 

The F6 key has different functions depending on the column in which the user finds himself. In the 

information window of the Transactions table, there is an explanation of the functions, which varies according 

to the column cell that has been selected.   

 Date: inserts the date in chronological order 

 Doc: inserts doc. number in increasing order 

 Description: recalls memorized rows or imports row values with similar texts 

 Debit A/C / Credit A/C: swaps the accounts 

 Currency Amount: recalls the exchange rate from the Exchange rate table and calculates the amount 

in basic currency. If, in the cell of the Exchange rate column, the exchange rate is being inserted 

manually, the F6 key calculates the amount in basic currency: in this case, there will be a warning 

that the inserted exchange rate is not the same as the one from the Exchange rate table.   

 Currency: calculates and inserts the exchange rate according to the amounts inserted in the cells of 

the Currency amount column and the Amount (Basic currency) column.  

 Exchange Rate: no function 

 Amount (Basic Currency): calculates and inserts the exchange rate in the Exchange rate 

column, according to the amounts inserted in the cells of the Currency amount column and the 

Amount (Basic currency) column.  

Pick up lines with the same text - Smart Fill 

The program memorizes the data previously inserted. When entering a new text (for example, when inserting 

a description or an account), by typing in just a few characters, all the texts that begin with the same letters 
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will appear in the lower information window. Press the arrow down key to get into the list and select the 

desired description. Then press Enter or F6 to confirm.  

 

  

3.1.18 Text input and smart fill 

The text input area presents a drop-down menu, from which a text that has been entered earlier, can be 

chosen and automatically entered. 

The text input area is situated right below the toolbar. To edit an existing cell, click with the mouse on the 

area and proceed to edit, or hit the F2 key. 

At the left side of the text input area, two icons appear to cancel or to accept the inserted text. 

 

 

 

New features:  

If you don't remember the account number, just type a text in the text input zone and in the list you will see 

all the accounts which contain the typed text in their description.  

In order to access the list, use the Down arrow key.  

Difference with the former version:  

If the drop-down menu is opened, the Down arrow or Up arrow keys cannot be used to go to the cell that is 

situated above or under. The Down arrow or Up arrow keys are used to browse the drop-down list.  

In order to go to cell that is situated above or under, press the key Ctrl and Down arrow or Up arrow at the 

same time.  

Attention: to deactivate last year's smart fill, the user must deactivate the option "Smart fill with 

transactions from previous year" (File menu, File and accounting properties command). 

3.1.19 Wrap text 

When the text for a row is very long, the Calculate row height command from the "Format" menu allows 

the user to view it completely, adapting the height of the row. 

To adapt the height of the row to the text, the user should: 

 In the Data menu, activate the Set up fields command  

 Click on Edit attributes 

 Activate the option Wrap text  

 Recall the Calculate row height command each time it is necessary.  

The Calculate all row heights command is equal to the one described above, with the difference that it 

operates on all rows of the table.  

  

3.2 Organizing the documents 

At the basis of the accounting, there are the accounting documents and receipts. 
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The type of one's organizing with regard to the accounting, depends on the size of the activity and the 

amount of documents. 

The way one organizes things has to be adapted to what is needed. 

Here following is an indication of possibilities that have proven to be very useful. 

The different types of documents 

It is important to distinguish and organize specifically the different types of documents. 

 Basic documents: contracts for rent, telephone subscriptions, statutes, insurance contracts and 

everything that gets signed only once and is valid for several years.These documents need to be 

kept in a separate folder or binder, containing just this type of documents. For some of these very 

important documents (like receipts for down payments, etc) it may be useful to make a photocopy 

and keep the original in a safe or a safe place. Don't make holes in important documents, but put 

them in transparent plastic folders. This binder is the basis of your activity/company and you need to 

handle it carefully.  

 Documents related to employees: Contracts, insurances related to personnel, and other; it is 

useful to keep these in a separate binder.  

If there are lots of documents, we advise you to use one binder per theme.  

 VAT Declarations: it is good to keep a special binder with the different declarations that you 

present at a regular basis (quarterly, by semester or yearly). For your VAT inscription or other 

general documents, it is better to keep them together with the basic documents.  

 Accounting receipts and documents of the year: these are receipts, invoices or other 

items that are related to an expense or a receipt. These have to be kept separately, year by year. 

For every year you will have a binder with these kinds of documents.  

Accounting documents: 

A good day- to-day order is needed in order to enter the accounting transactions and to control the situation 

of the company, such as the cashflow, the totals of debtors and creditors, etc. 

1. All accounting documents (receipts, invoices, tickets) usually have to be kept for a minimum of ten 

years. 

2. Classify and put the accounting documents in order by date, together with the related bank 

statements for the payment or the receipt.  

3. Write a progressive number on the accounting documents (statements and others). With this 

number, that should be inserted in the Doc column, you can locate the accounting document, with 

the accounting as a starting point.  

4. At the end of the year, print a copy of the journal and keep it together with the accounting 

documents. 

5. Usually a new binder is being used for each year for the accounting documents.  

Issued invoices or receipts with an accounting at the moment of payment 

Small companies and associations enter the invoices only in the accounting at the moment of payment (cash 

method). 

1. Separate the issued invoices and those for which you have received the payment.  
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2. Verify regularly the invoices on hold for which payment still needs to be received. As soon as the due 

date for the payment has passed, it is useful to send a payment reminder. Don't let too much time 

pass by, make sure you receive the payment for unpaid invoices. This takes time, but is it important.  

3. Once these invoices are paid, put them together with the normal accounting documents.  

Issued invoices or receipts with an accounting on the sales volume 

The invoices are being registered at the moment they are issued as well as at the time of payment.  

See also: Clients/Suppliers Registers 

1. Separate the issued invoices and those for which you have received the payment.  

2. Verify regularly the invoices on hold for which payment still needs to be received. 

As soon as the due date for the payment has passed, it is useful to send a payment reminder.  

Don't let too much time pass by, make sure you receive the payment for unpaid invoices. This takes 

time, but is it important.  

3. When you enter the issueing of the invoice in the accounting, make note of the registration on the 

invoice. On the transaction row, use the "Doc. Original" column to insert the invoice number.  

4. Once the are invoices are paid, move them over to the "paid" section, and enter them in the 

accounting.  

5. When you have entered them, make note of the accounting transaction on the invoice (for example 

with a "checked" sign)  

Transactions / frequence 

 It is good to regurlarly enter the transactions in the accounting (daily, weekly, monthly). 

 We strongly advice you to not neglect entering the accounting transactions, so that you always have 

updated information and can evaluate the progress of your activity.  

 By going over the different expenses account numbers, you can easily have an overview of the 

different expenses that you made. 

 The accounting is not just done for the tax authority.  

3.3 Cash book 

The ideal instrument to manage the income and expenses of one single account (cash, bank account, etc.). 

Perfect for keeping the petty cash or to manage individual projects (associations, small companies). 

Available with or without VAT/Sales tax.  

  

Characteristics 

 Manages the receipts and expenses of one single account (for example, cash, current bank or postal 

account, or other)  

 Allows the user to enter the transactions  

 In the Cash Book with VAT management, it calculates and furnishes automatic VAT reports  

 Elaborates automatically annual and periodical reports, with profit or loss indication, and cash 

variations.  
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Getting started 

 From the "File" menu, activate the New command and select Cash book. One can choose 

between a Cash book with or without VAT/Sales tax. 

In order to facilitate starting, we advice to open one of the existing templates and elaborate the 

necessary adjustments. 

 

  

  

 Enter the personal data in the File and Accounting properties (Basic data)  
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 Save the file under a new name 

 In the Accounts table, insert the amount of the opening balance in the Opening column.   

This operation needs to be executed only the first time, when the Cash Book file is created; from 

then on, at every year end, when creating a New Year, the opening balance is automatically 

updated.  
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 Customize the Categories table. 

 

 Insert the transactions in the Transactions table 

 After having registered the operations in the Transactions table, the Enhanced statement can be 

obtained. 



46 

B A N A N A  A C C O U N T I N G   

 

 How to organize yourself for keeping an accounting.  

 Cost centres in the Cash book 
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3.3.1 Tables 

Doing your personal accounting with the Banana Accounting Cash book is very easy, you just have to 

rename the cash account in the Accounts table and arrange the income and expenses categories in the 

Categories table.  

The "Accounts" table 

In the “Accounts” table it is possible to arrange the desired account (cash, bank, post office or other account) 

depending on the type of business being carried out.  

View of the Accounts table in the Banana Accounting Cash book  

 

 

  

The “Categories” table 

In Banana Accounting, the categories come arranged on the basis of existing models. When it is necessary, 

existing categories can be modified or new ones can be added.  

View of the Categories table in the Banana Accounting Cash book  
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The "Transactions" table 

The list of daily income and expenses  

Take a few minutes every week to organize the receipts from the income and expenses and to enter the 

transactions. You can write and correct like a word processor. At the end of the month, you can also print the 

monthly statement.  

 

 

The columns of the Transactions table in Banana Accounting's Cash book 

Date  The date in which the expense occurred or when income was received    

Document  The receipt/invoice number (this column is not mandatory)    

Description   The description of the income or expense transaction   

Income  The incoming amount (earnings, salary)  

Expenses  The expense amount (costs)    

Category  The category number    

Balance  The progressive balance (calculated by the program)    
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The program automatically calculates the balances. Errors and differences will show immediately.  

 

3.3.2 Transactions 

To enter transactions in the Cash book, activate:  

 the Transactions table 

 insert the data in the columns: the date, description, the incoming or expense amount of the account; 

in the "Category" column, the category number associated with the type of income or expense (for 

example: sales, rent, etc.) is being inserted.  

The Balance column is automatically updated by the software, after every transaction.  

  

To accelerate entering the transactions, consult Repetitive operations.  

Attention: to deactivate last year's smart fill, the user must deactivate the option "Smart fill with 

transactions from previous year" (File menu, File and accounting properties command).  

  

Transaction examples without VAT/Sales tax  

 

 

  

Transaction examples with VAT/Sales tax  

 

 

 

Note: In the Transactions table, instead of the account number, write the text you wish to find.  

The software will show in the window at the bottom of the screen the list with all the accounts containing the 

entered text. With the right arrow key you can move directly in the list. You can select the desired account 

number by double-clicking it with your mouse or by pressing the Enter key.  
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After having entered the transactions, in order to display the mouvements of an account or a category, 

double click on the account- or category number:   

 

Example 

In the category card, the presentation of the transactions is very similar to the one of the Transactions table.  

 

 

In every transaction row, the balance of the cash account or the category is automatically reported.  

 

3.3.3 Statement 

The main Cash Book print-out is the Enhanced Statement. Other print-outs are possible and they are (or not) 

in common with the other accouning types. 

Before visualizing the Enhanced Statement, it is necessary to recheck the accounting to make sure there are 

no mistakes, by means of the Recheck accounting (Shift+F9) command from the Cash1 menu.  

With this command:  

 The categories will be checked  

 The transactions will be checked  

 The totals and balances will be recalculated  

Final Statement 

If the Enhanced statement command (Cash1 menu) is selected, the opening and closing balances as 

well as the operating results deriving from income and expenses will be obtained automatically.  
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The Banana Accounting Cash book can be downloaded free on the following website: www.banana.ch  

3.4 Simple accounting 

The Simple accounting is ideal for small businesses and associations. It allows the user to manage the 

receipts and expenses of several accounts. In order to organize your documentation, please consult 

organizing the documents. 

  

Characteristics  

 Manages the accounts that are part of one's own estate (cash, bank, post, clients...)  

 Manages the income and expenses (Categories table)  

 Calculates and presents the account and category balances also in the second currency.  

 In the accounting with VAT/Sales tax, provides also automatic VAT reports 

 Elaborates automatic annual/periodical reports, with profit or loss indication, and the increase or 

decrease of the estate. 

http://www.banana.ch/
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How to start 

 From the File menu, activate the New command and select Simple accounting. You can 

choose a Simple accounting with or without VAT management. Our advice is to select a preset 

model or example.  

 

 Adapt the data of the File and Accounting properties (this Window will pop-up automatically 

when creatina a new file, or it can be recalled anytime by choosing the File and Accounting 

properties command form the File menu)  
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 Insert the opening balances in the Opening column. Please remember that, for the Liabilities' 

accounts (f.i. debts), the opening balance should be preceded by the minus (-) sign. This operation 

needs to be executed only the first year; from then on, at every year end, when creating a New Year, 

the opening balance is automatically transfered. 

 

 In the Categories Table, arrange the income (earnings/revenue) and expense (expenses/costs) 

categories, assigning each one a code, description and the belonging group. The categories should 

not have any opening balances at the beginning of the year.  

 Enter the accounting transactions in the Transactions table.  

 After entering the transactions you can easily obtain the Enhanced Statement: 
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3.4.1 Tables 

The Accounts Table 

In the Accounts Table, arrange the accounts belonging to the estate, assigning a code, description and the 

groups to which they belong.  
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Continue entering the opening balances in the Opening column of the Accounts Table.  

  

The Categories Table 

In the Categories Table, arrange the income (earnings/revenue) and expense (expenses/costs) categories, 

assigning each one a code, description and the belonging group. The categories should not have any 

opening balances at the beginning of the year. 
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The Transactions table 

This is where the daily income and expense transactions need to be entered. It takes a few minutes every 

week to record the daily accounting operations based on the accounting documents.    

 

 

 

The columns of the Transactions table in Banana's Simple accounting  

Date the date in which an expense occurred or income was received   

Document code number of the invoice/receipt (column not obligatory) 

Description description of the income or expense transaction 

Amount the income or expense amount (the expense must have the (-) sign in front)  

Account the estate account code related to the operation 

Category the category code related to the operation    

  

After every transaction entered all balances are automatically updated. Errors and differences will 

show immediately. 

  

The Account/Category Card 

The Account/Category Card is the list of all transactions belonging to a specific account or category.  

To obtain the account/category card, double-click on the account or category number.  

 

 

 

In every transaction row, the account/category balance is automatically reported. 

 

3.4.2 Transactions 

The transactions are entered in the Transactions table.  
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Insert the data in the columns: the date, description, the incoming or expense amount, the account, the 

category.  

Income/Expenses: the amount coming in/going out.  

Account: one of the estate accounts (cash, bank, post, clients, suppliers,...) is entered.  

Category: an income or expense category is being entered  

  

To accelerate entering the transactions, consult Repetitive operations.  

Attention: to deactivate last year's smart fill, the user must deactivate the option "Smart fill with 

transactions from previous year" (File menu, File and accounting properties command).  
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Examples of transactions without VAT  

 

 

  

Examples of transactions with VAT  

 

 

  

Note: In the Transactions table, instead of the account number, write the text you wish to find.  

The software will show in the window at the bottom of the screen the list with all the accounts containing the 

entered text. With the right arrow key you can move directly in the list. You can select the desired account 

number by double-clicking it with your mouse or by pressing the Enter key.  

  

After having entered the transactions, in order to display the mouvements of an account or a category, 

double click on the account- or category number:   

 

Example 

In the account- or category card, the presentation of the transactions is very similar to the ones of the 

Transactions table.  
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In every transaction row, the account/category balance is automatically reported. 

 

3.4.3 Enhanced Statement 

The Enhanced Statement is calculated and visualized by means of the command Enhanced Statement, 

from the Simple1 menu.  

In the window that appears, a series of options can be selected so that more information can be included.   

  

 

 

The Enhanced Stament gives an overview of the advancement of the estate situation and the operating 

result of the year. This function is present in the Cash book and the Simple accounting.    
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3.5 Double-entry accounting 

The professional instrument to manage assets, liabilities, expenses and income according to the 

international rules of the Double-entry (debit and credit). Charts of accounts that can be personalized, 

VAT/sales tax options, data import and export are only a few of the numerous functions.      

See also: How to get organized 
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Double-entry accounting is mandatory for all companies or other entities who, by law, are obliged to present 

a Balance Sheet and a Profit/loss Statement.  

  

Characteristics  

 Manages the estate accounts and the profit/loss accounts (assets, liabilties, expenses and revenue)  

 The accounting type with VAT features the VAT calculations and VAT reports  

 Produces all the accounting registrations: journal, account cards, balances by period and annual 

balances   

 Exports data to Excel, Html, Xml  

 Imports data from a Cash book or Simple accounting file and in a text format   

 Imports data from bank statements in MT 940, QIF, QFX, Postfinance and Raiffeisen format 

  

When creating a new accounting file, it is always better to open an already set example and adapt it to one's 

own needs, instead of starting from zero.  

 Choose the type of accounting needed and select in "Examples/Prototypes" the example that best 

suits your needs 

 

 Define the Accounting Properties  
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 Save the file under a new name (Save as...)  

 In the Accounts Table, make all the necessary changes to personalize your charts of accounts: you 

can add or delete lines, change the accounts numbers and descriptions, create more groups, etc. 
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In case an account is missing, just move to the Accounts table, add a new row and complete it with the 

account number, the description, the Bclass and the Group in order to create a new account. 

For more information on how to create a Chart of Accounts, please consult the section Groupings in the 

Chart of Accounts. 

 Save your file and go to the Transactions Table to enter your accounting transactions.  
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The Results 

Example of a Enhanced balance sheet by groups at Year's end: 
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3.5.1 Liabilities and Income are negative? 

Yes. In double-entry accounting, the balances can be in debit or credit. Banana indicates that an account is 

in credit by writing the amount in negative. The assets and the expenses are usually in debit, whereas the 

liabilities and the income are in credit. The negative sign is a convention, other programs use letters (D, C) or 

brackets.  

See also in: Mathematical basis of the Double-entry accounting.  

 

3.5.2 Tables 

Accounts table 

In the Accounts table, the Chart of Accounts is being entered: The Assets and Liabilities accounts make up 

the Balance Sheet, the Expenses and Income (Revenue) make up the Profit & Loss Statement.  

For every account, enter:  

 the description 

 the BClass (1 for Assets, 2 for Liabilities, 3 for Expenses, 4 for Income) 
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 the Gr to which the account belongs 

 the opening balance in case Banana Accounting is being used for the first time (in the following 

accounting years, the transfer of the balances takes place automatically with the Create New 

Year function) 

In Banana Accounting, you must always remember:  

 The debit balances are positive 

 The credit balances are negative (with a minus sign in front). 

Please note: this rule only applies when you manually insert opening balances.  

To correctly configurate and set up the chart of accounts, we advice you to study the lesson "Groupings in 

the Chart of accounts"  

  

Assets and Liabilities  
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Expenses and Income  

 

 

 

The total debit balance must be equal to the total credit balance  
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Transactions table 

In the Transactions table, all the accounting transactions are being inserted; it represents the Journal.    

 

 

The columns of Transactions table:  

Date The date in which the payment, purchase or invoicing occur    

Document The receipt number    

Description Indicates the cause of the accounting registration   

Debit A/C The number/code of the registered debit account    

Credit The number/code of the registered credit account 

Amount The amount resulted from the receipt   

  

Totals table 

The Totals table shows the totals per Group and serves to double check whether the accounting balances. It 

is calculated automatically by the program and the user cannot edit it.   
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3.5.3 Creating a budget 

In order to create a budget, the "Budget" view has to be displayed on the Accounts table.    

 Insert the foreseen amounts in the Budget column. The software updates the differences between 

the accounted amounts and the foreseen ones in the "Diff. Budget" column. 
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3.5.4 Groupings in the Chart of Accounts 

In order to set up a chart of accounts, create the principal groups; for every group a Gr, to which the group 

belongs, has to be indicated:  

 00 groups the accounts of the balance sheet 

 2301 indicates the profit or loss of the current year 

 02 groups the accounts of the profit & loss statement 

 

 Add new, blank rows; complete the process by inserting the account numbers, the description, the 

BClass and the Gr to which the accounts belong. The BClass cannot be changed: 1 for the assets, 2 

for the liabilities, 3 for the expenses, 4 for the income. 
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The accounts from 1000 to 1360 have Gr 1, equal to Group 1 which adds up the Total assets 

The accounts from 2000 to 2300 have Gr 2, equal to Group 2 which adds up the Total liabilities 

The Total assets and Total liabilities have 00 as Gr, equal to Group 00 where they are added up, obtaining 

the balance of the Balance sheet.  

The procedure for the Profit & Loss statement continues in the same way:  
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The accounts from 3000 to 3340 have Gr 3, equal to Group 3 which adds up the Total expenses 

The accounts from 4000 to 4200 have Gr 4, equal to Group 4 which adds up the Total income  

The Total expenses and the Total income have 02 as Gr, equal to Group 02 where they are added up 

(Profit/Loss from Profit & Loss Statement). 

The Profit/Loss from the Profit & Loss Statement has 2301 as Gr, and is added up in the 2301 group in the 

liabilities.  

 

3.5.4.1 Subgroups in the Chart of Accounts 

In the Chart of Accounts, the subgroups give the possibility to obtain totals on more than one level and 

obtain more detailed information in the presentation of the Balance sheet. 

Example: 

The user wants to create a new subgroup "Liquid assets" that groups the cash, bank, and post office 

accounts. 
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To create the sub-group "Liquid assets": 

 insert a few empty rows 

 in the Group column, key in the "100" code 

 in the Description column, key in "Total Liquid assets" 

 in the Gr column, key in "1" 

 in the Gr column of the 1000, 1010 and 1020 accounts, key in "100" instead of "1". 

 

 

3.5.4.2 Deleting subgroups 

If the Chart of accounts has some sub-groups that are no longer needed, it is possible to delete them. 

  

Example: 

The user wants to delete the sub-group "Total loans". 
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To delete the sub-group "Total loans", the user must: 

 delete row 20 

 change the Gr for the 2100 and 2400 accounts from 200 to 2. 

 

 

3.5.5 Accounts with VAT codes 

In an accounting with VAT, the user can, at the moment the Chart of Accounts is created (Accounts table), 

connect a VAT code to the income/expense accounts, so that, when the sales and purchases are being 

recorded, the program automatically inserts the VAT code and completes the columns with the VAT data 

while entering the account number.    

In order to connect the codes:  

 Click on the "Other" view 

 Insert the VAT codes for the income/expenses in the "VAT code" column  
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3.5.6 Entering opening balances  

When using Banana Accounting for the first time, the opening balances need to be inserted manually in 

order to create the opening balance sheet.  

After having set up the Chart of Accounts, proceed as follows:  

1. Place yourself in the Accounts table, Base view, Opening column. 

2. Enter the opening balances of the Assets and Liabilities accounts manually. The Liabilities are 

entered preceded by the minus (-) sign.  

3. Check if the total Assets equals the total Liabilities so that your accounting balances.  
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In order to automatically transfer the opening balances for the next year, consult the lesson "Updating 

opening balances". 

 

3.5.7 Transactions 

Sales in cash 

Debit A/C: 1020 (Bank 1) 

Credit: 4100 (Income from sales)   

Amount: 8'000.00   
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Office supplies in cash 

Debit A/C: 3000 (Purchase goods for resale) 

Credit: SU-001 (Company 1)   

Amount: 80.00    

 
 

Bank Deposit in cash 

Debit A/C: 1020 (Bank 1) 

Credit: 1000 (Cash) 

Amount: 500.00    

   

 

Pay different bills with a unique bank transfer 

Credit: 1020 (Bank 1)Debit A/C: 3250 (Electricity)   

Debit A/C: 3270 (Telephone) 

Amount: 300.00 (subdivided in the different rows)   
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Debit Cash different bills from the bank account 

Debit A/C: 1020 (Bank 1) 

Credit: 4100 (Income from sales)   

Amount: 9'500.00  

 
 

Make purchases on credit 

Debit A/C: 3000 (Purchase goods for resale) 

Credit: SU-001 (Company 1) 

Amount: 1'500.00  

 
 

Sales on credit 

Debit A/C: CL-001 (Company 1) 

Credit: 4000 (Income from sales)  

Amount: 1'500.00   
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Note: In the Transactions table, instead of the account number, write the text you wish to find.  

The software will show in the window at the bottom of the screen the list with all the accounts containing the 

entered text. With the right arrow key you can move directly in the list. You can select the desired account 

number by double-clicking it with your mouse or by pressing the Enter key.  

 

3.5.7.1 Transactions on multiple accounts 

Simple transactions are being entered on the same row, with one account in debit and the other in credit. 

Composed transactions have to be entered on several rows. The user should enter one account per row and 

there can be several counter parties in debit and/or credit.  

  

To accelerate entering the transactions, consult Work rapidly.  

Attention: to deactivate last year's smart fill, the user must deactivate the option "Smart fill with 

transactions from previous year" (File menu, File and accounting properties command).   

  

Example  

The user pays by means of the bank several invoices: consultancies 1'500.-, rent 1'800.-, insurances 350.-, 

invoice for purchased goods 3'600.-  

 

 

 

3.5.7.2 Issuing bank checks 

To enter issued bank checks, the user needs to insert an "Issued checks" account in the Liabilities.   
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The check is issued at the moment of paying a supplier and is being debited from the Bank current account.  

 

 

 

The "Issued checks" account card after the transactions. 
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3.5.7.3 Entering a credit note 

When a product has been sold and the client finds a defect, usually a credit note on his behalf is being 

issued. The credit note implies a decrease of the income and as a result a recovery of the VAT (Sales tax).  

Example:  

We enter an amount of 1.500.-, including 20% VAT, for sales.   

 

 

 

Due to a defect of the sold products, we issue a credit note for the amount of 150.- to the client.    
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For a recovery of the VAT on the amount of the credit note, the VAT code of the sales has to be entered with 

a minus (-) sign preceding the code.  

3.5.7.4 The contra account in the account cards 

In the Account cards, the Contra Account column (C-Acct.), which indicates the account that completes the 

transaction, is being shown. 

When there are transactions on multiple accounts (transactions on multiple rows), and there is one account 

entered in debit and several accounts in credit, or the other way around, the software deducts the possible 

contra account using the following logic: 

 The first transaction row is considered the contra account of the transactions that follow. 

 On the Account card of the first transaction row, the contra account is indicated with the [*] symbol, 

which means that we are dealing with a transaction on multiple accounts. 

 On the Account cards of the next transactions, the contra account is indicated between square 

brackets ("[1020]"), and indicates a deducted contra account.  
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3.5.8 Accounts with addresses 

When you have a Clients/Suppliers register in the Chart of Accounts, and when it is needed to have 

complete data with the address, telephone number, email address, VAT/Sales tax number, etc., you can set 

up and visualize these data by activating the Address view.  

  

To activate the Address view and visualize the data, proceed as follows:  

1. Place yourself in the Accounts table 

2. From the "Tools" menu, click on the Add new functionalities command  

3. In the window that appears, confirm the option "Add fields addresses in Accounts table" with OK 

4. In the Address view, insert the data for Clients/Suppliers. 

 

 

The Address view has several columns of which the header can be edited. The amount of visible columns 

can be edited through the "Data" menu, Set up fields command.  

In the example, because of the space, not all the available columns are shown.  

 

3.5.9 Year's end and New Year's setup 

Before closing the year and opening a new one, or after any important modifications, it is necessary to 

perform a global recalculation to check if there are possible differences.  

 

Rechecking the accounting - Shift+F9 

From the  Account1 menu, selecting the Recheck accounting command, or by simply pressing the 

Shift+F9 keys, the whole accounting file is being recalculated and rechecked in order to verify if there are 

errors or omissions. The program sets the balances at zero, recalculates and verifies the complete 
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accounting file, entry by entry, just as though all the entries were to be rewritten manually. It even 

recalculates the VAT/Sales tax percentages (except for locked transactions). If there are many errors, click 

on the Don't warn option; the messages will anyway be saved in the message window and can be seen 

afterwards.  

3.5.9.1 Balance sheets and Reports 

The main print-outs of the Double-entry accounting are:  

 Enhanced balance sheet 

 Enhanced balance sheet by groups 

 Report 

 Other printouts 

3.5.9.2 Updating opening balances 

When, in the opening balances, there are differences, visible in the row "Difference should be = 0 (blank 

cell)" or when in the previous accounting changes have been made, or when the profit or loss of the current 

year have not been allocated, it is necessary to update the opening balances.   

The update procedure is the same for the different cases: 

 Open the file of the current year and in the Account2 menu, click on the "Update opening balances" 

command  
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 Select the file of the previous year 
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 Select the account to which the result of the accounting year should be allocated 

 

 

The program automatically updates the opening balances; the "Total assets" matches exactly the "Total 

liabilities".   
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3.5.9.3 Balance in the Accounting 

At the opening of the accounting period, the accounts of the Assets have to balance with the accounts of the 

Liabilities. If not, it is impossible to have a correct balance in the accounting. Therefore, it is important to 

check that there is no message "Difference in Opening balances" in the information window. Should this be 

the case, the user needs to modify the different balances of the Balance Sheet accounts, Opening column, 

so that the total of the Assets corresponds to the total of the Liabilities (Opening column). 
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After having verified and corrected the opening balances, the Total Assets has to match the Total Liabilities. 
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It is possible to double-check the balancing in the "Totals" table. 
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3.5.9.4 Differences in the Transactions 

When, after recalculating, there are accounting differences in the "Transactions" table, the program gives the 

amount of the difference in the information window on the lower part of the screen. Very often these 

differences are due to incomplete recordings.   

By selecting the Search for transaction difference command in the "Account1" menu, the program 

shows the row that is at the origin of the possible difference.   

 

 

3.5.9.5 Creating an accounting file for the New Year 

At the end of every accounting year, the program gives the possibility to automatically pass on the new year, 

even without having allocated the profit or loss of the year that just ended. 

 Open the current file and click on the "Create New Year" command in the Account2 menu: a window, 

that shows a difference corresponding to the profit or loss that has not yet been allocated, will 

appear. There may also be differences due to accounting errors. 

 From the list that appears, the user can select the account to which the result of the accounting 

period has to be allocated, or one can directly confirm with "OK" if the allocation of the result has to 

be postponed. 
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 Confirm the File and accounting properties for the new year 

 

 From the File menu, activate the "Save as..." command, indicating the folder where the new 

accounting file needs to be saved. 
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Updating the opening balances 

In case the previous year has been closed and changes have been made afterwards, the opening balances 

of the already opened new year need to be updated. For more information, please consult the lesson Update 

opening balances. 

3.6 Multi-currency accounting 

Multi-currency accounting is based on the Double-entry accounting method and manages accounts in 

foreign currency. In the chart of accounts, in addition to the basic currency, there are also accounts in foreign 

currency.     

In the Balance sheet herunder, the Euro has been used as basic currency. In the assets there are two 

accounts in USD and one in CHF, for which the amounts have been converted to Euro's, based on the 

exchange rate inserted in the Exchange rate table.    

  

Characteristics 

The multi-currency accounting has the same characteristics as the double-entry accounting, plus some 

special multi-currency features: 

 Manages the estate accounts and profit/loss accounts (assets, liabilities, expenses and income) in 

foreign currency.  
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 Calculates the conversion automatically, based on the exchange rate inserted in the Exchange rate 

table.   

 Calculates the exchange rate differences automatically.  

When starting working with Banana mult-currency accounting, we suggest to choose one of the already 

configured examples and to personalize it instead of starting from a new blank file:  

 

 

 Enter the basic data in the File and accounting properties window 



94 

B A N A N A  A C C O U N T I N G   

 

 Insert the accounts in foreign currency and the accounts for the exchange rate profit/loss of the 

Chart of accounts.If you don't know them yet you can always recall this windows ba choosing the 

File and accounting properties command from the File menu. 
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 Set up your accounting plan by addig, editing, deleting rows or groups; for more information visit the 

page of the Groupings in the Chart of Accounts of the double-entry accounting 

 Define the exchange rates in the Exchange rate table  

before entering the transactions in foreign currencies, the exchange rates in the Exchange rate table 

have to be updated.  

 Save your file changes and go the the Transaction table to enter your accounting transactions. 

  

The Results 

Example of a Enhanced Balance Sheet at year's end: 
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Other resources: 

 Organizing the documents 
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3.6.1 Chart of accounts 

Assets and liabilities  

The accounts of the Balance Sheet (assets and liabilities) can be in any kind of currency.  

 

 

 

In the Chart of Accounts, the currency of the account, defined in the Foreign Exchange Rate table, has to be 

specified for every account.  

Expenses and Income  

The accounts of the Profit and Loss Statement (Expense and Income) have to be specified in basic currency.  
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3.6.2 Opening Balances 

The first time Banana accounting is being used, after setting up the Chart of accounts, the user needs to 

insert the Opening balances.  

 The Opening balances have to be inserted in the Opening currency column ("Account" table, 

"Base" view), both those that refer to basic curreny as well as those that are in foreign currency.  

 Please note that the opening balances for the liabilities have to be entered with the minus sign (-

) before the amount    
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The opening balances for the Assets and the Liabilities have to be balanced. You may to consult the 

following lesson: Balancing the opening balances.   

 

3.6.3 Exchange rate table 

Before defining the codes for the accounts in the “Currency” column of the Account table, the parameters of 

the currencies need to be specified in the Foreign Exchange Rate table  

 

 

Date 

This is the date when the exchange rate was used. The program only uses exchange rates with no date. The 

date column is only used in the exchange rate history.  

Warning: if a date is entered in the Foreign Exchange Rate table, the exchange rate will not be used by the 

program, and an error message will be appear in the Transactions table declaring: currency symbol does not 

exist. 
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Currency Ref. 

This is the currency that serves as the basis for the change (the Euro in our example.) 

 

Currency 

This is the destination currency, the one into which the value of the “Currency Ref.” will be converted. 

 

Text 

A text to specify exactly which foreign currency is being dealt with. 

 

Fixed 

True or false. If there is a fixed exchange rate, enter Yes in this column. In this case, the exchange rate used 

will not be the opening one, but the rate specified in the Exchange Rate column. 

 

Mult. 

The multiplier is usually 1, 100 or 1000 and is used to obtain the effective exchange rate. The multiplier is 

used for currencies which have a very low unit value in order to avoid having to insert exchange rates with 

many zeros. The multiplier can also be negative (-1). In this case, the program will use an inverted exchange 

rate or else it will act as if the currencies inserted in the Currency and Reference Currency columns had 

actually been inverted (exchange rate = 1/exchange rate).  

Warning: do not alter the multiplier once there are already transactions in the same currency. The program 

will signal a transaction error due to erroneous exchange rates. 

 

Exchange rate 

This column shows the actual exchange rate for the currency with respect to the reference currency. 

 

Opening Exchange rate 

This is the exchange rate at the moment the accounting is opened. It is used to convert the opening amount 

of the currency into the opening amount of the accounting’s basic currency. Insert it only once when the 

exchange rates are input because the program will then pick it up automatically at the beginning of a new 

year. 

 

Minimum 

This column shows the minimum exchange rate accepted. If a lesser exchange rate is used during the entry, 

there will be a warning. 

 

Maximum 

This column shows the maximum exchange rate accepted. If a greater exchange rate is used during the 

entry, there will be a warning. 

 

Decimal Points 

This column shows the number of decimal points to be used when rounding the amounts in currency2.  

3.6.4 Transactions 

Establishing the exchange rate  

Before entering a transaction in foreign currency, the Foreign Exchange Rate table needs to be updated 

(Exchange rates column) with the daily exchange rate. In the Transactions table, the program calculates the 

exchange values according to the inserted exchange rate, and takes the eventual exchange rates profits or 
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losses into account. The exchange rate difference depends on the exchange rate inserted in the Foreign 

Exchange Rate table.  

Every day there is a different exchange rate and thus also the values of the Balance Sheet change on a daily 

basis. Except in special cases, the Foreign Exchange Rate table doesn’t need to be updated every day. The 

update of the exchange rates is done when updated or conclusive reports need to be printed.  

Types of entries allowed  

For each entry there are two accounts (debit account and credit account) and there can be the following 

direct combinations:  

 Entries between two accounts in basic currency (EUR EUR)  

 Entries between an account in foreign currency and one in basic currency (USD EUR)  

 Entries between two accounts in the same foreign currency (USD USD), but not in basic currency  

It is not possible to register a transfer between two accounts in different foreign currencies in a single row 

when one is not the basic currency (USD YEN).  

  

Note: the expenses and the income need to be entered with the daily exchange rate and thus have to be in 

basic currency.  

Exchange rate to be used  

For certain operations you need to keep in mind that it might be necessary to use a predefined exchange 

rate (banking transactions). In these cases you need to use the indicated rate and the program will 

automatically calculate the exchange value in basic currency. Banks specify exchange rates with few figures 

after the decimal point and often round the amounts. On these occasions you input the exchange value in 

basic currency and leave it to the program to work out the actual exchange rate.  

  

The exchange rate used can influence the calculation of VAT. If you invoice goods to a customer from your 

country in USD, the calculation of VAT will be made on the EUR exchange value. The exchange rate used 

will determine the amount of VAT due. National VAT legislation will tell you which exchange rates to use 

under such circumstances.  

Other factors can determine the exchange rate to be used. For some kinds of transactions, loans and 

shares, the exchange rate of the time of purchase (historical one) is often used, independent from exchange 

rate fluctuations.    

Manually inserted Exchange rate 

When it is necessary to insert an exchange rate directly in the Exchange rate column (Transactions table), 

different from the one in the Exchange rate table, the user must, in order to calculate the amount in basic 

currency, put himself in the cell of the Exchange rate column and press the F6 key.  
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To accelerate entering the transactions, consult work rapidly.  

Attention: to deactivate last year's smart fill, the user must deactivate the option "Smart fill with 

transactions from previous year" (File menu, File and accounting properties command).   

3.6.4.1 Transactions table 

In the Transactions table there are several fields: 

 

 

Date 

The date of the operation. 

Doc 

The number of the document.  

Description 

The description of the transaction.  

Debit A/C 

The account in which the amount is recorded in debit.  

Credit A/C 

The account in which the amount is recorded in credit.  

Currency Amount 

The amount of the transaction (any currency).  

Currency 

The code for the currency.  

Exchange rate 

When dealing with a transaction that is not in basic currency, this is the exchange rate between the foreign 

and the basic currency. The exchange rate is automatically recalled from the Foreign Exchange Rate table.  

Amount USD 

The amount expressed in USD. When dealing with a transaction that is not in basic currency, this is the 

amount that has been converted from the foreign to the basic currency. This conversion is automatic 

according to the exchange rate.  

  

3.6.4.2 Entries in Basic currency 

This is a simple entry with the Debit and the Credit account in basic currency (Euro in the example).  
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3.6.4.3 Entries with accounts in basic and foreign currency  

The classical operation that represents this case is a money transfer from an account in basic currency to an 

account in foreign currency and vice versa. When you know, from the bank statement, the amounts both in 

basic and in foreign currency, the procedure is as follows:  

 Insert the exchange rate from the bank statement in the Exchange rate table. 

 Enter the debit account, the credit account, and insert the foreign currency amount in the 

Currency amount column.  

The software uses automatically the exchange rate from the Exchange rate table and inserts the basic 

currency amount in the Amount column.  

 

Example: when a transaction is entered on a USD account, the currency of the transaction has to be the 

USD.   

 

   

Effects on the Account cards  

On the 1000 account, the basic currency amount of 67.34 Euro is being entered on the debit side (Basic 

currency view)  

 

   

On the 1032 account, the foreign currency amount of 100.00 USD is being entered on the credit side 

(Currency view).  
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3.6.4.4 Entries between two accounts both in a currency other than the basic currency 

In the example, there are two USD (foreign currency) accounts withour an account in basic currency. The 

amounts are automatically being converted into basic currency.  

 

   

Effects on the Accounts cards  

   

On the 1034 account, the foreign currency amount of 1'000.00 USD is being entered on the debit side 

(Currency view).   

 

   

On the 1032 account, the foreign currency amount of 1000.00 USD is being entered on the credit side 

(Currency view).  
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In the Basic currency view, we can find the amounts, automatically converted by the program according 

to the exchange rate inserted in the Foreign Exchange Rate table.  

   

On the 1034 account, the basic currency amount of 673.40 EUR is being entered on the debit side.   

 

   

On the 1032 account, the basic currency amount of 673.40 EUR is being entered on the credit side.   

 

3.6.4.5 Entries between two different foreign currencies 

When there is an operation between two different currencies, USD and CHF for example, it is not possible to 

make the entry on a single entry row.  

You will have to use two entry rows and operate if you were entering two different operations.  

 Enter on the first row the debit account and the foreign currency amount (CHF in the example). 

 Enter on the second row the credit account and the second foreign curreny amount (USD in the 

example). The program will now signal a difference, because the automatically calculated amounts 

in basic currency are different.  
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 On the second row, copy the amount in basic currency from the former row. (EUR 615.27 in the 

example) and press F6 to calculate the exchange rate. The entry is now complete and there are no 

accounting differences.    

 

  

Effects on the Account cards  

On the 1035 account, the foreign currency amount of 1’000.00 CHF is being entered on the debit side 

(Currency view)  

 

  

On the 1032 account, the foreign currency amount of 804.66 USD is being entered on the credit side 

(Currency view).  

 

3.6.4.6 Entering exchange rate differences 

In order to calculate the exchange rate differences, the account or the accounts for the exchange rate 

differences should be present in the Chart of accounts. Also, in the "File and Accounting properties" of the 

File menu, these accounts should be indicated in the Foreign currency tab.    
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Enter the necessary transactions; to calculate the exchange rate differences, proceed as follows: 

 Update the Exchange rates table with the closing exchange rates for the end of the year or period 

 

 Execute the command "Create transaction for exchange rate variation" (Account2 menu) 

The software calculates the exchange rate differences automatically. 

 

 

  

Please note: these automatically created entries for the exchange rate differences can be cancelled or 

modified like any other entry.  
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3.6.4.7 Error message: "Currency symbol not found" 

In version 4, the absence of a currency symbol in the Transactions table was interpreted as a transaction in 

Basic currency.  

In version 5 every transaction needs to have its own currency symbol. Thus it is necessary to complete the 

transactions where no currency symbol has been inserted.  

 

3.6.5 Print-outs 

All the possible print-outs of the multi-curreny accounting are in common with other accounting types; please 

visit the corresponding pages:   

 Journal  

 Account card   

 Balances by period   

 VAT registers  

 External accounting report   

 Enhanced Balance sheet   

 Balance by classes  

3.6.6 Closing procedures 

At the end of the year, you have to proceed in the following way:  

 Input any entries necessary before the transfer to the new year (Transitory, amortisation, warehouse, 

etc.)  

 Correct any eventual errors the program signals. Execute this operation until all the errors have been 

eliminated. 

 Check the balance of the accounting in the opening balances  

 Correct any eventual differences in the opening balances or the transactions 

 Enter the exchange rate differences   

  

For the end-of-year printouts, go to Year's end and New Year's setup of the Double-entry accounting. 

3.6.6.1 Balancing the opening balances 

To create the new accounting year, activate the command Create New Year (Account2 menu). All data 

will be automatically transferred with the opening balances of the Balance sheet. Save the file under a new 

name.   

 

Balancing the balance sheet (basic currency)   

At the opening, the exchange value in basic currency of the total assets should correspond to the total 

liabilities (in negative). Thus the sum of assets and liabilities should amount to zero. If the total assets does 

not correspond to the total liabilities, then the accounting does not balance and is therefore not correct.    

A difference in opening balances can be caused by various causes:   

 An amount has been input incorrectly  

 Credit balances have not been input in negative 

 Opening exchange rates have not been correctly indicated 

 Exchange rate differences have not been registered at the closing of the previous year.  

 There is a rounding difference due to a different way of calculating the exchange value.    

Totals table: Control of the Balance   
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3.6.6.2 Exchange rate differences in the opening balances 

When, in the preceding year, the exchange rate differences have not been calculated, the program signals, 

in the new year, a difference in the opening balances. In order to resolve this problem, there are two 

possibilities: 

 If the former accounting year has not yet been audited, one can calculate the exchange rate 

differences in the preceding year, by inserting in the Exchange rate table the official exchange rates 

at 31.12 (Exchange rate column) and activate, from the "Account2" menu the Create transaction 

for exchange rate variation command. Afterwards, open the file for the new year and transfer 

automatically the balances of the preceding year. 

 If the preceding year has already been closed and revised, you must proceed in a different way: 

open the file of the new year and insert in the assets or the liabilities, according to the situation, a 

new account "Unrecorded Exchange rate differences" (Accounts table) and, in the Opening column, 

insert the amount corresponding to the exchange rate difference. At 01.01, the exchange rate 

difference account has to be put to zero by means of a transaction (Transactions table), using the 

account related to the exchange rate differences (Exchange rate profit/loss) of the profit/loss 

statement as its counterpart. 

Differences in the opening balances 
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Adding of the account "Unrecorded Exchange rate differences" 

 

 

  

Transaction to put the account "Unrecorded Exchange rate differences" to zero 

 

 

  

Result of the transaction in the "Unrecorded Exchange rate differences" account  
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3.7 Addresses/labels 

For managing lists and printing labels  

 Unrestricted field definition  

 Option to print only selected lines  

 Unrestricted definition of label layout 

 Copy/paste addresses from other programs (Excel and Word) 

Complete and free of charge for everyone!  

Table showing the list 

 

  

Parameters for printing labels  
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Printing labels 

 The program centers the text on the label  

 Automatic reduction of characters for labels with long texts 
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3.8 VAT/Sales tax 

Set up and operations with VAT/Sales tax.  

3.8.1 Theory 

VAT (Value-added Tax) is a tax that weighs on the final consumer. Every VAT subject must calculate and 

periodically deposit the tax to the Revenues Authority.  

Every country has its own VAT rates that are established in different percentages depending on the type of 

merchandise or service. Certain merchandise and services are exempt or excluded.  

The percentages vary according to the financial necessity of the country; therefore, there can be changes 

over the years.  

  

VAT rate 

In this document, to make calculating easier, we will use the following rates:  

 10 % normal rate 

 5% reduced rate  

 0% excluded operations or exempt operations 

VAT calculation 

Net Price x VAT Percentage / 100 = VAT Amount  

  

Example 

Net price 300  

Tax rate 10%  

VAT amount = 300 x 10 / 100 = 30  

  

Gross price calculation 

Net price + VAT Amount = Gross Price  

  

Example 

300 + 30 =  330  

  

Sometimes the gross amount is known and it is necessary to find the net and VAT 

amounts.  

Net price calculation 

Gross Price / (100 + VAT rate) x 100 = Net Price  

  

Example 

330 / (100 + 10) x 100 = 300  

  

The net price represents the cost (purchase) or the revenue (sale) of the company  
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VAT amount calculation 

Gross Price - Net Price = VAT Amount  

  

Example 

330 - 300 = 30  

or  

330 - [330 / (100 + 10) x 100] = 30  

  

The VAT amount represents the debit (sales) or the credit (purchases) towards the Revenues Authority.  

  

VAT rate calculation 

VAT Amount  / Net Amount x 100  = VAT Rate  

  

Example 

30 / 300 x 100 = 10%  

or  

[330 - 330 / (100 + 10) x 100]/100 = 10%  

  

Another example 

20 / 400 x 100 = 5%  

  

This way of calculating is used when the rate is not known.  

3.8.2 VAT Codes Table 

The VAT Code table setup allows the definition of all the parameters that are necessary to manage the 

transactions with VAT. The setup refers to:   

 VAT due or recoverable  

 Transaction amount recorded as net, gross, or VAT amount at 100% (Customs VAT)  

 Freely definable applicable VAT rates  

 Freely definable account in which VAT must be recorded  

 Special rounding off for each code  

 Definable grouping and totaling method 

The VAT Codes table has a Base view and a Complete view (see the table hereunder). The difference 

between the two is the fact that the Complete view presents several columns that are not available in the 

Base view. These columns serve to accommodate some specific options.    
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Calculation modality  

The parameters indicated in the VAT Codes table are being used to calculate the VAT of the individual 

transactions. The parameters established in VAT Codes table cannot be changed in the transactions. This 

modality guarantees that the VAT calculations are correct and uniform.  

Please note: if the values of a VAT Code, which has already been used in the transactions, are being 

modified, the changes are not active immediately; in this case it is necessary to activate the Recheck 

accounting command (Account1 menu -> Recheck accounting). When the VAT Codes table is being 

modified, the program invites the user to execute a complete recalculation as a precaution.   

   

Detailed description of the columns 

In the following columns, insert the following data:  

 Group: a code or number that identifies the group to which the code belongs. In the example we 

have inserted 1 for the sales, 2 for the purchases, T for the total.   

 VAT Code: the code to identify and carry forward the VAT code in the transactions.   

 Description: a text for the description of the VAT Code or the group.    

 Gr: code of the "Group" in which the row has to be added.  

 Gr1: code for additional groupings.  

 Gr2: code for additional groupings. 

 Due VAT:  

If the word "Yes" is being inserted, this means that the VAT is at debit (due to the state)    

If the cell is empty, this means that the VAT is at credit (recoverable)   

 Amount type: indicates how the software considers the transaction amount: 

0 (or empty cell) with VAT/sales tax (the transaction amount is considered VAT included)   

1 = without VAT/Sales tax;  

2 = VAT amount (the transaction amount is considered the VAT amount)   

 % VAT: VAT code percentage   

 VAT% on gross: is usually being left empty. In special cases, the word "Yes" has to be inserted 

only if the VAT percentage has to be applied on the gross amount (VAT included) and not on the 

taxable amount.   
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 VAT amount: the account number on which the calculated VAT is being registered in the chart of 

accounts   

 Round Min: minimum value for rounding, to use only in particular cases. By preference, the 

rounding indicated in the basic data of the accounting (f.i. minimum rounding value 0.05) is being 

used. 

 Don't warn: there are particular transactions that the software could interpret as mistaken, but 

which, in reality, are correct. In order to avoid that the software signals error messages, insert the 

word "Yes" for the code that is concerned.   

When the transactions with VAT are inserted, by applying the VAT Code in the "VAT Code" column, 

the software calculates automatically all the amounts related to the VAT and transfers them in the VAT 

account.     

Adding a new percentage   

When a new percentage is added, a new row has to be added; in the new row, insert the data of the 

new VAT code with the new percentage. Don't change a code that has already been used in the 

transactions.     

Groupings 

By creating groups with multiple totalling levels, the user can obtain the totals that are necessary for the VAT 

declaration.    

In the VAT report, by activating the option "Use own grouping scheme", the software calculates the totals 

exactly as indicated in the sequence of the indicated groupings.    

The groupings are being used to obtain totals for groups of transactions, for example, the totals for all 

exportations or importations.   

 

   

   

3.8.3 Transactions  

Before entering the accounting transactions, the Automatic VAT account and the "VAT to be paid" account 

(or VAT Revenue Authority account) need to be entered in the Chart of accounts, or, alternatively, enter the 

traditional VAT accounts (Recoverable VAT and VAT due).  

In the VAT codes table, there are codes both for the sales and the purchases. When entering the 

transactions, use the appropriate VAT code.  Some examples: 

 

Cash Sales  

The VAT code for the sales is being applied (S10)  
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Purchase in Cash  

The VAT code for the purchases is being applied (P10).  

 

The software automatically splits the VAT amounts and records them in the Automatic VAT account or in the 

VAT account that has been indicated by the user in the VAT codes table. 

  

 Automatic VAT Card  

 

  

Cancellations 

When an earlier entered operation needs to be cancelled, the VAT code needs be preceeded by the minus 

sign for the VAT to be cancelled. The VAT code that should be used is the same as the one that has been 

used earlier to record the operation that now has to be cancelled. By proceeding this way, the VAT amount 

will be corrected.    

Instead of the minus sign preceeding the VAT code, it is also possible to use codes that refer to discounts 

and that are already configured in the VAT codes table.   

3.8.3.1 Transactions at the end of a period 

At the end of a period, the balance of the Automatic VAT account (or of the Recoverable VAT and the VAT 

due account) needs to be transferred into the VAT to be paid account (or VAT Revenue Authority). 

Before entering the transaction into the accounting, the user needs to verify whether the balance of the 

Automatic VAT account or the VAT to be paid account (VAT Revenue authority) corresponds with the 

amount indicated by the VAT report.    
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In order to close the Automatic VAT account at the end of a period, a transaction needs to be entered by 

which the actual balance is being transferred into the VAT to be paid (or Revenue Authority) account.  

 

 

  

After the transaction, the balance of the Automatic VAT account will be zero.   

 

 

 

  

The recording of the VAT payment brings the balance of the VAT to be paid (or Revenue Authority) account 

back to zero 
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3.8.3.2 VAT partially deductible 

In certain countries, there are special cases, prescribed by law, in which the VAT (Sales tax) cannot be 

completely deducted.   

Example:  

Dinner with clients for the amount of 150 (VAT included). A deductibility of 50% is allowed.  

The transaction is entered by inserting the VAT code as usual, but in the "%Exempt" column, the percentage 

that cannot be deducted should be entered. In the "VAT Acc" column, the actually deductible VAT is shown.  

 

 

 

3.8.4 Automatic VAT account  

The Automatic VAT account is inserted in the chart of accounts and can be defined as the default account in 

the File and accounting properties, VAT tab. In this case, the VAT account does not need to be inserted in 

the VAT Codes Table. 
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If, on the contrary, the automatic VAT account has not been configured as the default account, it needs to be 

indicated in the VAT Codes table, in the VAT account column. 

As an alternative to the traditional system with several VAT accounts (Recoverable VAT, VAT due, VAT 

Revenue authority), it is possible to have the Automatic VAT account and the account "VAT to be paid" in the 

chart of accounts. The software inserts automatically, in debit or credit, the VAT amounts in the Automatic 

VAT account, according to the used VAT code. 

At the end of the period, the balance of the Automatic VAT account will be transferred to the VAT to be paid 

account. 

The VAT to be paid account will have zero as a balance at the moment the VAT is being paid. 

With this system it is possible to check the balance every quarter; in case of an error, it is easy to locate in 

which period the balance no longer corresponds. 

  

3.8.5 Carrying forward the VAT (Sales tax) credit 

When calculating the periodical VAT (Sales tax) report, it can happen that the recoverable VAT exceeds the 

VAT which is due. As a result the VAT Revenue Authority account closes with a difference to the advantage 

of the taxpayer. 

In the following window the account card for the Automatic VAT is shown. The balance of 667.45 is a VAT 

credit. 
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The balance of the Automatic VAT account has to be transferred to the VAT Revenue Authority account, like 

it has to be done at every end of period. 

 

 

 

After the transaction, the Automatic VAT account has a balance of zero 
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The VAT Revenue Authority has a balance in debit 

 

 

 

At the end of the period, the balance of the VAT Revenue Authority account has to been carried to zero. In 

order to do this, it is first of all necessary to define an appropriate VAT code in the VAT codes table, and 

complete it with the description, Gr, Amount type 2, percentage 100% and the Automatic VAT account. 
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In order to put the VAT Revenue Authority account to zero, the amount and the related VAT code have to be 

entered, only in credit. 

 

 

After the transaction, the VAT Revenue Authority account has a balance of zero. 
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The VAT credit of the previous period is shown in the VAT report. 

 

 

 

3.8.6 VAT Report at the end of a period 

The VAT Statement is a form sent from the Revenues Authority to all VAT contributors to declare the 

operations with VAT, divided by VAT rates. All data automatically calculated by the program must be 

reported manually on the VAT Statement form.   

To obtain the VAT Report: 

 Select, from the “Account1” menu, the VAT report command  

 Enter the period by clicking on "Period selected" and indicate the start and end date, or select the 

period directly. 
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 Choose the desired options 
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With the configurations in the Favorites tab, different models of VAT reports can be created, each one with 

different configurations. 

 

 

 

 

 

The amount due indicated in the VAT report has to correspond with the amount for the end of period of the 

Automatic VAT account or the VAT Revenue Authority account. 

 

The data of the VAT report can also be transferred to and elaborated by other programs (f.i. Excel, 

XSLT) and be presented in formats that are similar to the forms of the tax authority  

For Switzerland, one can automatically obtain a document similar to the form that has to be sent to the VAT 

office. This form shows the amount to enter for each number.  Please consult (in German, French, or Italian) 

MwSt-Formular 2010.  
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3.8.7 Carrying forward the VAT (Sales tax) credit - old 

When calculating the periodical VAT (Sales tax) report, it can happen that the recoverable VAT exceeds the 

VAT which is due. As a result the VAT Revenue Authority account closes with a difference to the advantage 

of the taxpayer. 

In the following window the account card for the Automatic VAT is shown. The balance of 667.45 is a VAT 

credit. 

 

 

The balance of the Automatic VAT account has to be transferred to the VAT Revenue Authority account, like 

it has to be done at every end of period. 

 

 

 

After the transaction, the Automatic VAT account has a balance of zero 
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The VAT Revenue Authority has a balance in debit 

 

 

 

At the end of the period, the balance of the VAT Revenue Authority account has to been carried to zero. In 

order to do this, it is first of all necessary to define an appropriate VAT code in the VAT codes table, and 

complete it with the description, Gr, Amount type 2, percentage 100% and the Automatic VAT account. 
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In order to put the VAT Revenue Authority account to zero, the amount and the related VAT code have to be 

entered, only in credit. 

 

 

After the transaction, the VAT Revenue Authority account has a balance of zero. 
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The VAT credit of the previous period is shown in the VAT report. 

 

 

 

3.8.8 Printing the VAT registers 

The printout of the VAT registers reports all transactions subject to VAT, related to purchases and sales.    

To be able to print the registers of purchases and sales, Group 1 (Total VAT due) and Group 2 (Total 

Recoverable VAT) have to be defined in the VAT codes table, in addition to the VAT codes.   
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In the Account1 menu, click on "VAT/ Sales tax report":  

In the Period tab, enter the Start and End date of the period to be accounted.   

 

 

  

In the VAT tab, enter the desired options  
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The Favorites section allows the user to create and save different VAT report models, each one with its 

own configurations.  

For more information, consult the online lesson about the Favorites. 

The data related to the VAT are automatically displayed, according to the chosen options. 

 

 

  

3.8.9 Swiss VAT 

3.8.9.1 VAT on cash received and transitories at the end of year 

There are two methods, established by the Federal Tax Administration, for the collection of the Value Added 

Tax (VAT): 
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 Method according to the issued invoices - the determination of the VAT amount takes place at the 

moment the suppliers' invoices are received and the clients' invoices are issued. 

 Method according to the cash received - the determination of the VAT takes place at the moment 

that the financial transactions related to the receipt of payment for invoices take place. All those 

subject to VAT that manage the accounting operations with this method (after receiving the 

authorization from the office in charge), need to comply with the following regulations. 

1. During the accounting period, clients and suppliers should not be entered. 

2. The income/expenses need to be entered at the moment the payment is being registered. 

3. The VAT code needs to be inserted on the same row as the income or expenses account. 

Practical exemple 

 

 

  

In this case, for clients/suppliers management, we advise to use the cost centres. 

For the matter of the transitories (invoices issued for income/expenses, but not yet received or paid), only 

at the end of the year, carrying forward of the outstanding invoices of suppliers and clients is allowed. 

These issues are defined by the VAT regulations (Wegleitung 2001 zur Mehrwertsteuer, Z 964, Seite 219). 

Starting from here, we present you one of the possible solutions: 

  

Transitories at the end of the year 

At the end of the year, in order to exactly establish the profit or the loss of the accounting year, one needs to 

enter the transitories: 

 Expenses and income that refer to received and issued invoices at the end of the year, including 

outstanding projects, that will be paid and received in the following year. 

In this case, pay attention to not insert the expenses and income with the VAT code, for in the VAT report, 

the recoverable VAT and the VAT due have to be shown in the VAT report of the first quarter of the next 

year. 

In order to establish just the part of the expenses and the income (so without VAT) and entering the 

transaction correctly, one has to: 

  

In the Assets and Liabilities  

 In the Assets, open the account "Open client accounts" 

 In the Liabilities, open the account "VAT on open client accounts" 

 In the Liabilities, open the account "Open supplier accounts" 

 In the Assets, open the account "VAT on open supllier accounts" 
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In the expenses and income 

 In the expenses, open the account "Expenses for open supplier accounts" 

 In the income, open the account "Income for open client invoices" 
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For entering the transaction of the suppliers on 31.12....., one has to make an entry on several rows: 

 Enter in debit on the account "Expenses for open supplier accounts" the expense without VAT, 

without VAT code 
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 Enter in debit, on the account "VAT on open supplier accounts" the recoverable VAT amount 

 Enter in credit, on the account "Open supplier accounts" the total amount (VAT included) 

 

  

In the next year on 01.01..... the preceding operation needs to be closed, so the transaction is as follows: 

 Enter in debit, on the account "Open suppliers accounts" the total amount (VAT included)   

 Enter in credit, the expense without VAT, without VAT code 

 Enter in credit, on the account "VAT on open supplier accounts" the recoverable VAT amount 

 

  

At the moment the supplier's invoice is getting paid, the user has to enter the transaction as shown in the 

example at the beginning of this page, by inserting the VAT code as usual. 

  

 

  

For the transitories for the client invoices, the same procedure is being applied, but by entering on the 

preconfigured accounts related to the open client accounts.   
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3.8.9.2 Fixed rate VAT percentage 

There are specific legislations that use the payment of VAT/Sales tax at a fixed rate percentage. Usually, the 

percentage with which to calculate the VAT has been authorized by the tax authorities. The VAT/Sales tax is 

calculated on the gross amount of the sales, while the VAT/Sales tax on the purchases cannot be deducted. 

 

In Banana Accounting, there are two ways provided for the calculation of VAT/Sales tax: 

 Transactions without splitting 

 Transactions with splitting 

  

Transaction without splitting of the VAT/Sales tax 

Here a simple transaction needs to be entered, as the VAT/Sales tax is determined and entered at the 

moment of payment. In the accounting transactions, the sales (or other income subject to VAT/Sales tax) are 

shown with the gross amount, without splitting of the VAT/Sales tax amount. 

 

In order to determine the VAT/Sales tax, it is necessary: 

 To insert, in the "VAT codes" table, a VAT code with a percentage of zero (0%). 

 

 Every time when a sale is being entered, indicate the gross amount and insert the VAT code with a 

percentage of 0% in the "VAT code" column. 
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 At the end of the period, from the Account1 menu (Cash1 and Simple1 for the other types of 

accounting), activate the VAT/sales tax report command; by recalling the code with the 0% 

percentage, the gross sales volume (VAT/Sales tax included) can be obtained. 

 

 Calcolate manually, on the gross sales volume, the VAT/Sales tax to be transferred to the fiscal 

authorities, based on the percentage accorded by them. 

 At the moment the VAT/Sales tax is paid, enter the amount as a decrease of the income, using the 

sales account or another specific account. 
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Transaction with splitting of the VAT/Sales tax 

In this case, the sales (or other income subject to VAT/Sales tax) are entered by applying a code with a 

specific percentage that determines the splitting of the VAT/Sales tax amount from the gross sales volume. 

 

 

 Every time a sales transaction is entered, the specific code for the VAT/Sales tax at fixed rate needs 

to be entered in the "VAT Code" column. 
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 At the end of the period, by recalling the function "VAT/Sales tax report" from the Account1 menu, 

the amount due to the VAT authority can be obtained. The "Taxable" column reports the net amount 

(without VAT), but the VAT/sales tax amount is anyway calculated on the gross sales volume. 

 

 

  

  

3.8.9.3 VAT form for Switzerland 

From on 2011 in Switzerland  

 The VAT percentages of 7.6%, 2.4%, 3.6%  have been modified to respectively 8%, 2.5%, 3.8%. 

 The VAT declaration form has been changed. 

The following lessons indicate how to proceed in order to comply with the new requirements.  
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3.8.9.3.1 Swiss VAT Declaration form 2010 - 2011 

Banana accounting provides for a style sheet that allows the user to obtain automatically the Swiss VAT 

report, with the indication of the amount of every number, to transfer to the official form.     

The form functions at its best from on Banana accounting version 5.0.7 

In the year 2010, the new VAT regulations became applicable and in the year 2011, new percentages will 

need to be applied.  

From on the 1st of July 2010, the latest form, including the new 2011 VATpercentages (8%, 2,5% and 3,8%) 

is available. 

The VAT style sheet, that we make available, fonctions only combined with the new VAT codes 2010 - 

2011.   

Please note: in case the VAT codes 2010 - 2011 have been not been set up in the VAT codes table, the 

new VAT codes table needs to be imported.  

 

 

Here is how to proceed:  

 At the end of the period, after all the necessary transactions have been inserted, the data have to be 

exported in XML: in the File menu, click on the Export file command, Export file to XML. 

 In the area File name, insert the name of the accounting file for which the VAT report needs to be 

processed.  

 Activate the option Display file immediately so that the style sheet with the data for the VAT 

declaration will be directly displayed on the screen. 

 In the area Style sheet XSLT, insert the following path: 

until 30.06.2010 indicate the style sheet 

http://www.banana.ch/cms/files/vat_report_2010_ch.xsl 

from on 01.07.2010 indicate the style sheet 

http://www.banana.ch/cms/files/vat_report_2011_ch.xsl  

 (if desired, one can also download the style sheet on one's own computer) 
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 In the Include area, the options Datei-Infos (File info table) , MwSt-Zusammenfassung (VAT 

report)  und MwSt-Codes (VAT codes) have to be activated.  

 The option MwSt-Zusammenfassung Periode (VAT report Period) should not be activated.  
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 In the Period tab, select the desired period   

 

  

The declaration reports exactly all the indications of the VAT form; just transcribe the amounts related to the 

numbers on the official form.  
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In case there would be mistakes ( for instance, the corresponding number is missing for a code), the 

program gives a message in red print "Zur Kontrolle muss die Summe gleich Null sein" and 

indicates the difference.   

Download of the VAT Style sheet 

Should the user wish to obtain a copy of the executable file of the VAT form, the download can be done at 

the following link:  

Download MwSt/USt-Stilblatt 2010  

Download MwSt/USt-Stilblatt 2011 

Attention: place yourself with the cursor of the mouse on the executable file and with 

the right button, activate "Save link as" or "Save target as". 

The file needs to be saved in the same folder in which the accounting files are saved.  

 

Note: This official VAT form is only available in German, French and Italian.  
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3.8.9.3.2 Banana 5 and transferring to the new percentages 2011 

With Banana Accounting version 5, in order to correctly manage the transactions and elaborate the VAT 

form with the new VAT percentages, the user has to: 

 Make sure that he is using version 5.0.12 of Banana accounting 

 If needed, update to version 5.0.12 (Download page) 

 Download the new VAT Codes table (go to the corresponding page to find the explanations and the 

VAT codes table file to download) 

 Open his own accounting file, copy and paste the data of the VAT codes table of the already 

downloaded file. Make sure all the data are transferred correctly in the appropriates cells, especially 

those for the GR1 column. 

 In the File and accounting properties (File menu -> File and accounting properties -> VAT tab), 

indicate the Automatic VAT account. 

To elaborate the new VAT form, follow the instructions indicated on the following web page: #2362 

3.8.9.3.3 Banana 6 and transferring to the new percentages 2011 

In case you have created your accounting with an earlier version than 6.06 and you want to use the new 

VAT form 2010/2011, proceed as follows: 

 Download the new VAT codes table (check the special lesson) 

 Import the VAT codes table (check the special lesson) 

If the accounting has been created with Banana 5 and you are now working in Banana 6, you need to insert 

the automatic VAT account in the File and accounting properties -> VAT tab. 

3.8.9.3.4 Swiss VAT Declaration form 2009 

Banana accounting 5 provides for a style sheet that allows the user to obtain automatically the Swiss VAT 

report, with the indication of the amount of every number, to transfer to the official form.     

The form functions at its best from on Banana accounting version 5.0.7  

 Download VAT Report  

Attention: place yourself with the cursor of the mouse on the executable file and with 

the right button, activate "Save link as" or "Save target as".  

  

Here is how to proceed:  

 Download the style sheet for the VAT report and save it in the same folder where the accounting file 

is being stored   

 Place yourself in the "VAT codes" table, view "Complete VAT"; if, in the "VAT codes" table, the 

"GR1" column is not visible, then edit the table so that this column becomes visible  

 For every VAT code, insert in the "GR1" column the reference number of the VAT form   

 When a VAT code has to be placed in several numbers of the VAT form, you have to insert, in the 

corresponding cell, the numbers to which it refers, seperated by a semi-colon (;). 
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 At the end of the period, after all the necessary transactions have been inserted, the data have to be 

exported in XML: in the File menu, click on the "Export file to XML" command. 

 In the area "File name", insert the name of the accounting file for which the VAT report needs to be 

processed.   

 In the area "Style sheet XSLT”, insert the path and the name of the style sheet for the VAT report.  

 Activate the option "Display file immediately" so that the style sheet with the data for the VAT 

declaration will be directly displayed on the screen.   
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 In the Include area, the options "File info table" and "Transactions table" have to be activated.  

 The option "VAT/Sales tax report" in the period area should not be activated.  
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 In the Period tab, select the desired period   
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The declaration reports exactly all the indications of the VAT form; just transribe the amounts related to the 

numbers on the official form.  
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In case there would be mistakes ( for instance, the corresponding number is missing for a code), the 

program gives a message in red print "Zur Kontrolle muss die Summe gleich Null sein" and 

indicates the difference   
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Note: This official VAT form is only available in German, French and Italian.  

  

  

  

  

  

  

  

  

3.9 Advanced features 

3.9.1 Command Line and DDE 

Banana can be started by giving a series of command (for a list of command and examples file see below). 

It is possible to have Banana Accounting execute commands trough the: 

 Command line you can export the accounting to html, xml and excel, or import data in tables. 

 DDE interface (Dynamic Data Exchange) allow you to execute command to Banana and retrieve 

information. The DDE interface can be used within Excel, Access. 

Command line 

You can import and export data. 

If a command fail, than a return code different than 0 is returned, and the error is inserted in the log file (only 

if the option –log_file was used). 

 The arguments need to be preceded by a minus “-” sign. If an argument is missing of the “-” sign, it is 

interpreted as the name of the file to open. 

 Include the whole argument within the delimiter “…” if the text include whitespace. 

 Running import as command in the command line save the accounting file on exit 

 Example: open a file 

banana60.exe c:\temp\example.ac2 

banana60.exe "c:\temp\your example.ac2" 

  

Example: export to xml file 

banana60.exe -cmd=export "-cmd_file=c:\temp\my example.ac2"  

"-cmd_p1=c:\temp\myexample.xml" -cmd_p2=xml -period_begin=2006-01-01  

–period_end=2005-03-30 

Example: import transactions (use the file name with the proper directory name) 

banana60.exe -cmd=import -cmd_file="company.ac2" -cmd_table=Transactions  

-cmd_p1=import_mov.txt -cmd_exit=1 

For detail information regarding the import of transaction see the page "Importing in txt format". 

DDE interface for transferring 
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The DDE technology is been discontinued in some new Microsoft products and update. Therefore the DDE 

interface is is not guaranteed to work as described with new Microsoft products.  

 Through a DDE mechanism it is possible to: 

 Send command to Banana Accounting (with a scripring or a macro language) 

 Retrieve information form Banana Accounting 

The best way to learn how to use the DDE interface is to look at the example included. 

DDE issues 

If you experience that Excel stops responding and Google Chrome is running, close Google Chrome before 

opening the Excel document. 

If DDE links are not automatically updated in Excell follow the instructions at DDE links are not automatically 

updated in Excel 2007 

DDE link with Excel (Update the cell from data in Banana) 

 To send command to the software use 

Initiate the DDE sequence 

Service name: “Banana60” 

Topic name: “CONNECT” 

 DDEExecute channelNumber, Request 

 Request can be any command indicated command line 

 cmd=get_cell 

Example for Excel 

 =Banana60|CONNECT!'cmd=get_cell cmd_file=company.ac2 cmd_table=Accounts cmd_row=3 

cmd_column=Description' 

 =Banana60|CONNECT!'cmd=get_cell cmd_file=company.ac2 cmd_table=Accounts 

cmd_row=account=1000 cmd_column=Description' 

  

Available Command 

The argument “–cmd=…” specifies the command to be executed. The other arguments specify the option for 

this command. 

The command can be used as a command line  or a DDE request. 

 

Argument Description 

cmd= The command to execute 

file_open (cmd_p1=noshow) 

file_close (cmd_file) 

file_save (cmd_file) 

file_saveas (cmd_file, cmd_p1) 

http://support.microsoft.com/kb/930479
http://support.microsoft.com/kb/930479
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file_show (cmd_file) 

get_tableinfo  (cmd_file , cmd_table) 

get_getcell (cmd_file , cmd_table, cmd_column, cmd_row) 

get_getline (cmd_file , cmd_table, cmd_column, cmd_row) 

get_lasterror 

set_language(cmd_p1) 

calc_all (cmd_file) 

calc_simple (cmd_file) 

deleterows (…)    *) 

export (…) 

fileinfo (…) 

import (…)    *) 

acc_accountcard (…) 

acc_externalreport (…) 

acc_vatreport (…) 

  

1) Running import in the command line save the file on exit; 

*) If you use the commands “deleterows” and “import” directly from a command 

line the file is automatically saved on exit 

  

  

List of arguments 

Command Argument Description 

From command line cmd_exit=1 The program should exit and terminate 

Note if you use the command import= then the file 

that has been opened is automatically saved when 

the program terminate. 

For all commands cmd_file= the file to use or open 

cmd_pw= password to open the file 
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cmd_names= A - Field name in XML (default on) 

a - Field name in original language 

log_file= set the log file name for writing messages (if no file 

name no log) 

deletelines cmd_p1= start of line to delete (number) 

cmd_p2= how many lines to delete (if not present = 1) 

cmd_table= The name of table 

      

set_language cmd_p1= The two letter ISO639 language code (de, fr, en, it) 

      

file_open cmd_p1= noshow – do not show the file 

      

file_saveas cmd_p1= file name of saved file 

      

get_tableinfo cmd_table= The name of the table to get info 

      

get_getcell cmd_table= The name of the table 

cmd_row= The number of the row, or an expression like 

“Account=1000:3” (In this ex. the third row where the 

field Account is equal to 1000 is used) 

cmd_column= The name of the column 

cmd_op= A – Format value (default on) 

get_getline cmd_table= The name of the table 

cmd_row= The number of the row, or an expression like 

“Account=1000:3” (In this ex. the third row where the 

field Account is equal to 1000 is used) 

cmd_op= A – Format value (default on) 

export export_use_param Instead of the default parameters use the last saved 

parameters (set with the dialog)  and then applies 

the specified options with the other arguments 

cmd_p1= file name of the export file 

cmd_p2= Type: html, excel, xml 

cmd_table= The name of table to export (only the table is 

exported) 
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export_include= Options: 

Upper case(A) = on; Lower Case(a) = off 

A - Recheck accounting (default on) 

B - Include statistics table  (default on) 

C - Include transaction table  (default on) 

D - Include account table  (default on) 

E - Include category table  (default on) 

F - Include total table  (default on) 

G - Include Exchange rate table  (default on) 

H - Inclue Vat code table and vat report  (default on) 

I - Include Period Accounts  (default on) 

L - Include Period VAT  (default on) 

M - Create periods for the whole year  (default off) 

N – Create accounts card 

export_include_ma= number of months for accounts period, for  option I, 

(default 1) 

-1 for daily 

export_include_mv= number of months VAT period, for option L (default 

3) 

export_include_mm= max numbers of periods (default 36) 

export_op_html= Options for html 

A - Use style sheet 

B - Use predefined style sheet (default on) 

C - Include style shett within html file (default on) 

D - Export visible fields only (default on) 

E - Table with borders (default on) 

F - Columns with headers (default on) 
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G - Preserve page breaks within the table (default 

on) 

  

export_op_excel= Options for Excel export 

A - Define cell name  (default on) 

B - Define table name (default on) 

C - Use Xml names (default on) 

D - Protect tables  (default on) 

export_op_xml= Upper case(A) = on; Lower Case(a) = off 

A – Visible field only (default off) 

B – Include view list (default off) 

period_all period All 

period_begin= Begin date (yyyy-mm-dd) 

period_end= period End date (yyyy-mm-dd) 

vat_use_param= Instead of the default parameters use the last saved 

parameters (set with the dialog)  and then applies 

the options specified with vat_op 

vat_op= A - Include transactions 

B - Include total account 

C - Include total codes 

D - Include total percentage 

E - Use own group schema 

F - Only code specified 

G - Only group specified 

vat_sort= sort field 

vat_text= single code or groups (to use with –vat_op F and G) 

    

fileinfo cmd_op= A – Recalculate all (default off) 
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import cmd_p1= File name of the file to import. Data have to be 

separated by tabulator, and the first row has to 

contain the name of the fields. 

cmd_p2= Insert al line number (0=Append to end) 

cmd_op= A - Complete imported raws 

cmd_table= The name of table where to insert the data 

(Accounts, Transactions, …) 

    

acc_accountcard cmd_p1= account number 

cmd_p2= field name for sorting 

period_all period All (default) 

period_begin= Begin date (yyyy-mm-dd) 

period_end= period End date (yyyy-mm-dd) 

acc_externalreport cmd_p1= file name of the report 

cmd_p2= column name for grouping 

cmd_op= Upper case(A) = on; Lower Case(a) = off 

A - Include account with balance = 0 

B - Include account with no transactions 

C - Include totals only 

D - Notify if an account is without a group 

    

acc_vatreport period_all period All (default) 

period_begin= Begin date (yyyy-mm-dd) 

period_end= period End date (yyyy-mm-dd) 

vat_use_param= use parameters from existing dialog  + specified 

options like vat_op 

vat_op= Vat options 

Upper case(A) = on; Lower Case(a) = off 

A - Include transactions 

B - Include total account 

C - Include total codes 
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D - Include total percentage 

E - Use own group schema 

F - Only code specified 

G - Only group specified 

H – Not used groups 

vat_sort= sort field 

vat_text= single code or groups (to use with –vat_op F and G) 

    

  

Attachment Size 

Attachment Size 

BananaCommandLineExample.zip  50.3 KB 

BananaDDEexamples.zip  102.03 KB 

3.9.2 Cost and profit centers 

The cost and profit centers are groupings that make it possible to have details outside of the accounting.  

Especially for: 

 Projects 

 Events 

 Building sites 

 Clients and supplies 

 Members 

 Extra details for certain costs 

Characteristics 

 Each cost and profit center has its own account card 

 Un illimited number of cost centers can be created   

 Up till three types of cost centers can be managed, and each cost center can have different 

subgroups.   

3.9.2.1 Setting up Cost centers 

The Cost centers must be set up in the at the end of the Chart of accounts. There are up till three types of 

Cost centers, and for each type different subgroups can be created: 

 Full stop “.” ( for the CC1 column in the Transactions table) 

 Comma "," ( for the CC2 column in the Transactions table) 

 Semi-colon ";" (for the CC3 column in the Transactions table ) 

Example of creation of cost centers for managing yards 

 Create a cost centre for each yard 
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 The account is inserted, preceded by a full stop 

 

  

Making entries relating to cost centers 

 The number of the cost center (without the initial punctuation) must be entered in the respective 

column "CC1", "CC2", "CC3" of the Transactions table. 
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Negative entry 

 For Simple Accounting and Cash Book, the cost center entry follows the transaction amount. A 

negative entry is made in the case of expenses. 

 In double-entry accounting (and optionally for Simple Accounting and Cash Book) the cost center 

code is entered, preceded by a minus sign (credit) (-CC1, -CC2, -CC3). 

  

Accounts card 

 The cost center is processed like any other account 

 All the cost center transactions are recorded 
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VAT and cost centers 

The amount to be used for entries in cost centers can be defined: 

 Entry amount 

 Amount including VAT 

 Amount excluding VAT 

The preferences will be applicable to the whole accounting period. If this option is changed, the program will 

request a "Recheck accounting" command to be issued. 

  

Other resources relating to cost centers 

 The "Cost centers" view 

 Managing the membership list of an association 

 Managing several groups in a Cost center 

  

3.9.2.2 The "Cost centers" view 

The "Cost centers" view is shown in the Transactions table. There are three columns included, referring to 

the Cost centers: CC1, CC2, CC3. 

 

 

 

In case one of the Cost center columns would not be visible (Cost center view), it can be activated through 

the Set up fields command in the Data menu, by clicking on the "visible" box referring to the missing Cost 

center. 

  

Other resources relating to cost centers 

 Setting up Cost centers 

 Managing several groups in a Cost center 

 Managing the membership list of an association 
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3.9.2.3 Managing several groups in a Cost center 

In order to be able to manage several groupes of the same type in one cost center, you have to set up 

several groupings in the cost center of your choice (comma, full stop, semi-colon). In the following example, 

the groupings have been set up in a simple accounting in the cost center CC3 (with the semi-colon). 

 

 

  

To be able to enter the cost center that is linked to a specific grouping, the specific cost center account has 

to be entered in the CC3 column of the Transactions table (Cost center view). 

In the File and accounting properties (File menu), the option "Records (+/-) cost centers according to the 

category" should be activated. This option allows the user to have the amounts of the cost center as income 

or expenses, according to the category. 

Attention: in case this option has not been activated, the cost center has to be inserted preceeded by the 

minus sign (-), each time that there is a cost center that refers to an expense.   
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The amounts, the totals by group and the global total are automatically transferred into the cost center 

accounts. 
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Other resources relating to cost centers 

 Setting up Cost centers 

 The "Cost centers" view 

 Managing the membership list of an association 

3.9.2.4 Managing members 

The following images refer to the Double-entry accounting, but all the functions are also available in the 

Simple accounting. 

In order to obtain the membership list with all the data that are useful for an association, the user needs to 

proceed as follows: 

 In the Accounts table, at the end of the Chart of Accounts, the membership list can be created by 

using the CC3 cost center column. 
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 Activate the Address view, selecting from the Tools menu, the Add new functionalities 

command 

 In the window that appears, confirm the option Add fields addresses in Accounts table 

 Insert the data of the members 

 For a print-out: select the rows that need to be printed and activate the printing option only 

Selected rows only. 

 

  

In order to record the transfers from every member in the Transactions table, insert the CC3 account for 

each member, using the CC3 column. 

In order to display the CC3 column, click on the Set up fields command of the Data menu; double click 

on CC3 and activate "visible" by checking the small box below in the dialogue window. 

 

 

  

In the Accounts table, the balance of the member's transactions is shown. 
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To see all of a member's transactions, double-click on the CC3 account number. 

 

 

  

Other resources relating to cost centers 

 Setting up Cost centers 

 The "Cost centers" view 

 Managing several groups in a Cost center 

  

3.9.2.5 CC in the Cash book 

The cost centers allow the user to know the details of an income or expense category.  

The cost centers consent to having types of summing up totals different from those of the Categories table, 

without however modifying the accounting.  

Example: in the expenses, there is a category called “Health insurance”; if it is necessary to particularly 

know which expenses are the health insurance expenses for every member of the family, you can create a 

Cost Center. In general, the cost centers are listed separately, after the Categories. 

Setup of Cost Centers in the Cash book of Banana Accounting  

 

  

In the Transactions table, when the medical expenses are entered, insert the Cost Center initials (without the 

periods in front) in the CC1 column.  
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Transactions with Cost Centers in the Cash book of Banana Accounting  

 

 

  

Balances for Cost Centers after the transactions in the Cash Book of Banana Accounting  

 

 

  

Double click on the category of the Cost Center to obtain the Category card with all the details and the 

balance of the category.  

3.9.2.6 CC in the Simple accounting 

Determining the income and/or expense sub categories for every category  

The cost centers consent to having types of summing up totals different from those of the Categories table, 

without however, modifying the accounting.   

Example: there is an account called “Purchase goods for resale” in the expenses; if the user wants to know 

specifically which are the expenses for the different types of purchased goods, one can use a Cost Center. 

In general, the Cost Centers will be listed separately under the Categories.  

  

CostCenter set up in the Simple Accounting from Banana Accounting  
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In the Transactions table, (when the purchases are entered, in our example) indicate the Cost Center sign in 

the CC1 column without the punctuation in front.  

  

Transaction with Cost Centers in the Simple Accounting from Banana Accounting  

 

  

 

3.9.3 Inserting a link to a document  

In order to be able to insert a link to a document, the DocLink column should be displayed on the 

Transactions table (see also Editing the way columns are displayed).   

   

 

 Place yourself in the cell of the DocLink column and, from the "Account2" menu, activate the Add 

Link command  

 Select the file that corresponds to the document which needs to be connected and click on the 

"Open" button; the program inserts the link automatically.   

An internet address can also be inserted in writing in the Doclink cell.   
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In order to open the connected document, double click on the cell where the link is located.   

   

   

3.9.4 Managing several projects 

With the Segments feature, it is possible to manage different projects, obtaining balance sheets that 

determine the profit or the loss of each project.   

  

Example 

In an association, there are two projects that need to be managed: 

1. Courses 

2. Manifestations 

On top of that, there are different branch offices with the same projects to be managed: 

 Rome 

 Palermo 

 Florence 

The user wishes to obtain a balance sheet which indicates the profit or the loss of each project and branch 

office.   

  

How to proceed: 

 Insert the segments at the end of the chart of accounts 
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 Enter the transactions, and complete the debit and the credit accounts with the segments  

 

 From the Account1 menu, activate the "Enhanced balance sheet by groups" command 

 Select the available configurations in the different tabs; in the "Sections" tab in particular, deactivate 

the display of the Balance sheet accounts, the Client/Suppliers accounts and the Cost centers. The 

segments usually refer to the accounts of the Profit & Loss statement.  
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 In the "Subdivision" tab, activate the "Subdivision by segment" option 

 Select the segment for which the balance sheet should be obtained (by project or by branch office) 
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 Click on "Preview" in order to display the Balance sheet 

Balance sheet for projects 
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Balance sheet for branch offices 

 

 

3.9.5 Export data 

Export data  

3.9.5.1 Exporting accounting data in Excel, Html, Xml 

The data and accounting statements can be exported as:  
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 Excel files  

To create Excel spread sheets, comparisons, budgets, index calculations, Balance Sheet analysis, 

charts directly linked to accounting values.  

 HTML files  

The data and accounting statements can be easily accessed with an Internet browser (Explorer, 

Mozilla, Opera).  

This format fully complies with the legal requirements related to long-term archiving of accounting 

data.  

 XML files 

The standard used for exchanging data. The accounting data can be easily read and reused with 

other programs or with XSLT style sheets.  

Hereunder, the procedure for exporting the file to MS Excel is shown. The procedure for exporting the file to 

Html and Xml is exactly the same.  

 

 

Options for exporting to Excel 

In the "File" menu, click on the "Export file in MS Excel" command  

 

 

Select the data to be included  
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Each accounting table is a different tab in the Excel file  

 

 

 

Using cell names instead of row/column references:  

 The names show the desired value even when a new row or column is inserted.  

 The names are easy to use and understand  

"Account_1000_Balance" represents the balance in Account 1000. "Account_1000_Description" 

represents the value of the cell containing the description of Account 1000.  

 The names may be used in the formula's  
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"=Account_1000_Balance" will show the value of the cell containing the balance in Account 1000; 

"=Account_1000_Balance/1000" divides the balance of Account 1000 by 1000  

 Links can be made to various files using these names.  

The link to a cell consists of  

 The name of the file 

 The name of the table 

 The name of the cell 

 

 

3.9.6 Import data 

The functions for importing data are being presented.  

 

3.9.6.1 Import data from a cash book file  

In accounting it is possible to manage the petty cash separately and import the transactions, grouped 

according to a selected period and at regular intervals, in the current accounting file.    

There are two separate files: one file contains all the data of the general accounting, the other file contains 

only the data of the petty cash.   

In order to carry out the import of data, a link has to be established. This can take place in two different 

ways:  

 Attribute to the categories the same account numbers (for double-entry accounting), or, the same 

category numbers (for simple accounting) as the ones used in the general accounting file. 

 Transfer into the Category2 column (Category table) the corresponding accounts (double-entry 

accounting) or categories (simple accounting) of the general accounting file. If the Category2 column 

isn't visible, the user needs to visualize it by selecting the "Set up fields" command from the Data 

menu, with a double click on Category2 and activating the "visible" option.   

Example:  

In this example, the accounts referring to the general accounting have been entered in Category2 column.    
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In order to import the data, one needs to:  

 Open the general accounting file and in the Account1 menu, click on the "Import to accounting" 

command.  

 Click on "Import transactions", select "Cash book (*.ac2)" and with the browse button, select the 

cash book file. 
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 Enter the account number of the cash account in the general accounting file, the document number, 

the start and end date of the period to be imported and choose one of the options to group the 

transactions (monthly, quarterly, etc.)   
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The accounting file is updated with the data of the petty cash   

 

 

 

3.9.6.2 Importing data from e-banking bank statements 

The electronic bank statement can be directly imported in the accounting, so that you don't have to 

manually enter the transactions anymore: 

 Download the list of transactions in electronic format (executed or received payments) from your 

bank 

 With the Account menu ->Import to accounting command, indicate the transaction file to be imported 

(the one you downloaded from the bank)  

 Banana creates the transactions and transfers automatically, for each transaction: the date, the 

description, the amount (in debit or in credit)   

 The only thing that still needs to be done is to complete the imported transactions with the 

counterpart account, the VAT code (if necessary) or other information required by your accounting 

(Description, cost center, etc.)  
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Standard international bank statement MT940: 

Most of the banks give the possibility to download the transactions in the international standard format 

named MT940. 

Verify with your bank if the bank statements are available in that format.   

When you import the data of the bank, this is the format that needs to be selected.   

Other exchange standards: 

Banana Accounting supports also the following import formats made available by some banks: 

 OFX (Open Financial Exchange) 

 QIF(Quicken Interchange Format)  

 OFC (Open Financial Connectivity)  

Formats created by the banks: 

Some banks also have specific export formats that contain payment information that has not been included 

in the MT940 format.  

For some of them, taylor made import filters have been created that can found in the bank list. The 

inconvenience of these formats is that they are often being modified at the discretion of the banks. 

Therefore, the import filters might not function.   

For some banks, most of these specific files are created in the CSV (Comma-Separated Values) format and 

have been developed to transfer data into Excel. This is the case with the Raiffeisen and the UBS bank. 

Instead, Postfinance uses its own format that enables the user to download more than one bank statement 

at the same time. The import into Banana is however limited to one account at a time.   

For users who want to import e-banking data from institutions that export in a different way than those that 

are actually included in Banana Accounting, it is also possible for the user to create himself the import 

application, by using the Regular Expressions External Tool. Click here to see how.  

  



185 

B A N A N A  A C C O U N T I N G  

3.9.6.2.1 Import UBS bank statements 

In the following images, the UBS e-banking system has been taken as an example. For other banks, the 

system may be different. 

Visualize the desired bank statement and export it in CSV format.  

 

   

Save the bank statement in CSV format in the folder of your choice on your own computer  
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 From your Banana Accounting file, choose the Import to Accounting command from the 

Account1 menu 

 Select the option Import transactions and choose from the different formats the UBS (*.csv) 

format.  

 Insert the name of the bank statement in CSV format, that you just saved, in the File name area, 

selecting it with the Browse button.   

 Confirm with OK.  
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A second window appears, in which you can insert the Initial document number and the Destination 

account, which is the account to which the statement's data that you are importing - in this case the UBS 

bank account - belongs.  
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By confirming with OK, the data of the bank statement will automatically be imported in your 

Transactions table, from on the row where your mouse is being placed  
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Please note: after importing, the program shows you a Debit - Credit difference. 

This message is normal, because you still need to manually insert the counterpart accounts of the just 

imported transactions.    

3.9.6.2.2 Updating the e-banking import filters 

Banks or credit institutions may modify the format of their statements. For this reason, the import filters are 

being regularly updated. They can be manually updated in a fast and easy way, without the need to update 

or reinstall Banana Accounting. 

Updating procedure: 

1. Close Banana accounting 

2. Download the regextool.zip file, and open it 

3. Copy the file's contents in the following folder: 

Windows: "C:\Programmi\Banana60\ExternalTools directory" 

Mac: "[your username][Library]Application 

Support\Crossover\Bottles\NamesOfYourBottle\drive_c\Programs Files\Banana60" 

(administrator's access necessary) 

Implemented formats: 

Version regextool: 1.0.9.0  (02.11.2011) 

Description Last updated 

CBI (TXT) 23.11.2010 

China Construction Bank (CSV) 16.12.2008 

Credit Suisse (CSV) 09.11.2011 

Hypovereinsbank (CSV) 24.03.2009 

http://www.banana.ch/accounting/files/regextool.zip
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Luzerner Kantonalbank (CSV,ZIP) 11.10.2012 

Mijnpostbank (CSV) 10.11.2010 

MT940 in program implemented 

Open Financial Connectivity (OFC) 16.12.2008 

Open Financial Exchange (OFX) 16.12.2008 

Postfinance ESR V11 (V11) 06.03.2009 

Postfinance xml account card (XML) 16.12.2008 

Postfinance csv account card (CSV) 02.11.2011 

Quicken Interchange Format (QIF) 16.12.2008 

Rabobank (CSV) 11.11.2010 

Raiffeisen Bank (CSV) 15.10.2010 

St. Galler Kantonalbank (CSV,ZIP) 11.10.2012 

Thurgauer Kantonalbank (CSV,ZIP) 11.10.2012 

UBS Bank (CSV) 06.07.2012 

Zürcher Kantonalbank (CSV) no longer supported, see notes *) 

  

Notes: 

*) to import those formats, you need to upgrade to Banana 7 

  

For non implemented formats: 

New filters can be defined for formats that are actually not implemented. The instructions can be found on 

the following page: Regular Expressions External Tool 

We also have paid technical support available for the implementation of personalized formats. 

3.9.6.3 Importing transactions in txt format 

Use the import in to account in Menu Account1  

The type of file to be used is a "Text file with column headers". 

 You can use any column name existing on the table 

 Fields header in the first line o the file Fields names a case sensitive and must correspond to the 

NameXml (English) 

 Fields and column name separator is to be tab separated "\t" 

 Each line (after a "\n") is a new record 

 The format for the Date fields is yyyy-mm-dd 

Example file (without tab stop) 

DateDoc Description AccountDebit AccountCredit Amount VatCode VatPercentNonDeductible 

2006-01-03 Bank to Cash 1000 1020 350.00 

2006-01-05 Office Supplies 6500 1000 32.50 E76 

Options 
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 Import using clipboard data will use the content of the clipboard instead of the file 

 Autocomplete values Some fields of the transactions are automatically completed (see "Importing 

transactions for multicurrency double entry accounting"). 

 Unicode (utf-8) The content of the file is in Unicode utf-8 (it support any character set).  

Importing transactions for multicurrency double entry accounting 

By importing multicurrency data there can be rounding or calculation differences due to different 

development tools used. To avoid such differences you should provide only certainfield and while importing 

the program will calculate the field values that are missing (with theoption "Autocomplete values") . 

 If you provide only "AmountCurrency" the program will use the default exchange rate and will 

calculate the "Amount". 

 In order to avoid error provide always the "ExchangeCurrency" 

 If you provide the "AmountCurrency"  and the "ExchangeRate" and the "Amount" are 0 o not present 

the program will calculate the exchange rate based on the column "Amount" and "AmountCurrency". 

Automated data importing 

The import of transaction can be automated using the command or DDE. 

For further information see "Command line" 

  

3.9.6.4 Transferring data from other accounting software 

With Banana, you can easily transfer data from any accounting program, passing through MS-Excel. 

1. With the accounting program, export the data in a format that can be read by Excel (CSV, txt, ...) 

2. Open the file with Excel 

3. In Excel, organize the data (columns) as they appear in the Banana tables (Accounts, Transactions) 

4. Open your new accounting file in Banana 

5. In the Accounts or Transactions table, add as many empty rows as there are rows to transfer from 

Excel.  

6. In Excel, select the data to be copied and use the "Copy" command 

7. Go in Banana and execute the "Paste" command. 

This method is useful to transfer data from MS-Money, Intuit Quicken and Quickbooks, and from most other 

accounting programs.  

3.9.6.5 Import Rows 

In Menu Data -> Import Row  

You can import data in each table.  

The preferred format is a txt file with:  

- Fields header in the first line of the file 

Fields names are case sensitive and must correspond to the NameXml (English)  

- Fields are tab separated "\t"  

- Each line (after a "\n") is a new record  

- The format for the Date fields is yyyy-mm-dd  

- The format for amount or number is ####.##  

use always the point "." for decimal separator  

do not use any separator for thousands (amount will be truncated)  

   



192 

B A N A N A  A C C O U N T I N G   

Date  Doc  Description  AccountDebit  AccountCredit  Amount  VatCode  

2006-01-13     Payment VAT  2020  1010  1000.00     

2006-01-13     Withdral from bank  1000  1010  350.00     

2006-01-13     Office supplies  3260  1000  30.00  P76  

2006-01-13     Sales cash  1000  4100  200.00  S76  

   

Options 

- Import using clipboard data it use the content of the clipboard instead of the file  

- Autocomplete values Some fields of the transactions are automatically completed (see "Importing 

transactions for multicurrency double entry accounting").  

- Fields header The first line indicate the field header, otherwise the field sequence should be the same 

as the view.  

- Unicode (utf-8) The content of the file is in Unicode utf-8 (it support any character set).  

-  

Importing transactions for multicurrency double entry accounting 

- By importing multicurrency data there can be rounding or calculation differences due to different 

development tools used. To avoid such differences you should provide only certain field and while importing 

the program will calculate the field values that are missing (with the option "Autocomplete values") .  

- If you provide the CURRENCY_AMT, CHANGE_CURRENCY, the AMOUNT and the CHANGE_RATE = 0 

the program will calculate the exact exchange rate. 

If you provide only CURRENCY_AMT the program will use the default exchange rate and will calculate the 

AMOUNT.  

- In order to avoid error provide always the CHANGE_CURRENCY.  

   

Automated data importing 

You can give an "import" command to Banana to import a data included in a file. The file content format 

should be in the format specified above.  

For further information see the document and example under "ExecuteCommand"  

   

cmd=import  cmd_p1=  File name of the file to import. Data have to be separated 

by tabulator, and the first row has to contain the name of 

the fields.  

cmd_p2=  Insert all line number (0=Append to end)  

cmd_op=  A - Complete imported raws  

cmd_table=  The name of table where to insert the data (Accounts, 

Transactions, ...).  
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An example:  

c:\>"C:\Program Files\Banana50\Banana50.exe" -cmd=import "-cmd_file=c:\temp\myaccounting.ac2" "-

cmd_p1=c:\temp\transactions.txt" -cmd_p2=0 -cmd_op=A -cmd_table=Transactions -

log_file="c:\temp\error.txt"  

   

Attachment Size 

Attachment Size 

transactions.txt  275 bytes 

3.9.6.6 New formats for importing 

Hereunder, the formats for importing data from the bank- or postal account statement are being listed. On 

our site, the import filters can be updated. 

 

 China Construction Bank (CSV)  

 Credit Suisse (CSV)  

 Hypovereinsbank (CSV)  

 Luzerner Kantonalbank (CSV,ZIP)  

 MT940  

 Open Financial Connectivity (OFC) 

 Open Financial Exchange (OFX) 

 Postfinance ESR V11 (V11) 

 Postfinance xml account card (XML) 

 Postfinance csv account card (CSV)  

 Quicken Interchange Format (QIF) 

 Raiffeisen Bank (CSV)  

 St. Galler Kantonalbank (CSV,ZIP)  

 Thurgauer Kantonalbank (CSV,ZIP)  

 UBS Bank (CSV) 

 Zürcher Kantonalbank (CSV) 

 

  

3.9.6.7 Import to accounting 

Menu Accounting1 / Cash1 / Simple1  

Users can find a series of options for importing data in to the table.  

Banana will make the necessary data conversion depending on the format used.  

   

Receipt/Payment transaction file  

You can import a file with columns header that include movement (income or expenses).  

This format is very useful to convert a bank account format in Banana.  

Field name should be on the first line  

Columns are separated by tabulators.  

   

Date  Description  Income  Expenses  ContraAccount  Account  

2007-01-02  paper     30        

2007-01-06  material for photographic competition  259.2  3000     



194 

B A N A N A  A C C O U N T I N G   

2007-01-12  telephone bill     57.2  3000     

You can also use other columns name that are in the transaction table  

   

Columns with special meanings  

Income Can also be negative  

ContraAccount The account number (debit/credit) or category  

Account If the file contains the movements of multiple accounts.  

The account of the transaction.  

   

3.9.6.8 ExternalTools 

Banana Accounting (starting from version 5.0.8) implements an interface that enables to call external 

applications (External tool) for the parsing of imported data. The external application is used to convert the 

input data in a txt file with a standard format as described in the previous chapter. This enables the importing 

of accounting data in any custom format (xml, v11, ...) as long as an external tool for the specific format is 

available.  

External tools are available under the command "Account 1 - Import to accounting"  

   

The External tool is a program (exe, script or other) that is executed by Banana.  

Banana awaits for the program to terminate and then uses the output file as an import.  

   

The External toolsshould have an .ini file (saved in UTF8) with the necessary settings that define the 

functioning.  

The ExternalTool should be on the "ExternalTools" directory under the program directory.  

   

Check the example.ini file to see the description of the available option.  

   

'ExternalTools specification  

'This file should be saved in utf-8  

   

'version is optional  

version=1.0  

'publisher name (optional)  

publisher=Banana.ch  

'Description of plug-in (usually in english)  

description=Example ini file for importing transactions  

'Description.languagecode used if the program language  

description.ita=File ini d'esempio per importare movimenti  

'fileExecute should be on the same place as the ini file  

FileExecute=example_copyfile.bat  

'parameters used to start the ini file (case sensitive)  

'$filein replaced by the file name to be processed  

'$fileout replaced by the file name used for the import process  

is the file where the plug-in should write the output  

'$lang the language code of program  

'$type the file type  

'$file the accounting file name  

parameters="$filein" "$fileout" $lang "$type" "$file"  

'task indicate what the import is for  

Task=import_transactions  

'Task=import_accounts  
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'Task=import_categories  

'Task=import_exchangerates  

'OutputType (Optional)  

OutputType=transactions_simple  

'RequireInputFile default is true  

RequireInputFile=true  

'useclipboard: if true use the output data should memorized in the clipboard  

UseClipboard=false  

'The time max that it will be waited for the tranformation  

WaitMaxSecond=9  

'The extensions used for browsing the input file  

FileFilter=Text (*.txt)|*.txt|All files (*.*)|*.*|  

FileFilter.ita=File di testo (*.txt)|*.txt|Tutti i file (*.*)|*.*|  

'debug if true the temporary output file is not delete  

'debug=false  

   

   

Attachment Size 

Attachment Size 

ExternalTools.zip  9.69 KB 

3.9.6.8.1 Regular Expressions External Tool  

Download 

regextool.zip (239KB), last update: 02.11.2011 

Description 

This is a ready to use configurable external tool. This tool uses the boost regular expression engine to parse 

and format the input data. The configuration is done in the external tool’s ini file. This enables to quickly 

extend the application to import new formats. 

The tool has too kind of parsing method. A row & field matching method and a search & replace method. 

You can use one or both of them, the row/field method will be executed first, the search/replace method as 

second step. 

With the row & field matching method you define a search pattern that identify a row of data, then you define 

a separate search pattern for every field that will be applied to every row match to extract the field data. The 

matched fields are written to the output with the given format and flags. You use this method to parse xml 

files like the Open Financial Exchange, or txt files with data on multiple lines like the Quicken Interchange 

Format. 

The search & replace method work like a simple search and replace. A pattern is searched and replaced 

with the given format and flags, the result is then written to the output. You use this method to parse simply 

txt files, like csv or tsv files. This is the preferred method if you simply have to prepend the header line, or 

change the format of the values. 

If an error occurs, in the clipboard or in the given output files an error message starting with the text "error:" 

will be written and the value 1 is returned to the launching application. 

  

Through the following parameters you can configure the tool: 

  

Base parameters: 

http://www.banana.ch/accounting/files/regextool.zip
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useclipboard 1 
If set to "true" the filter output the result to the clipboard, otherwise to the given 

output file. 

filter_codepage 0/1 

The code page used to parse the input data. You can insert the code page 

number or one of the followings strings ACP, MACCP, OEMCP, SYMBOL, 

THREAD_ACP, UTF-7, UTF-8, UTF-16BE, UTF-16LE, UTF-32BE, UTF32LE. If 

empty or not set the tool look if a BOM (byte order mask) is present in the file, or 

try to guess the code page in the following order: UTF16LE, UTF16BE, UTF8, 

ANSI. 

The result is written to the output file in UTF-8, or to the clipboard in UTF-16LE. 

filter_header 0/1 

Define the header to prepend in the result data. This is equivalent to the column 

header. It is possible to use escape sequences, like '\t' for tabulator. Example: 

'Date\tDoc\tDescription\tIncome\tExpenses' 

filter_reverse_order 0/1 Output the transaction in reverse order. 

filter_archive_path 0/1 

If a zip or tgz archive containing more than one file is opened, it is possible 

through this parameter to define the name of the file in the archive to be readen. 

This parameter can contain perl regular expression. Only the first file that match 

the parameter will be imported. 

debug 0/1 
If set to "true", the tool write to the console the results of every regular 

expressions. 

  

Parameters for the row & field matching method: 

filter_row_match 0/1 Search pattern that identify a row (transaction, account, ...). 
1 globally 

filter_row_flags 0/1 Flags used for the filter_row_match. 

filter_field_match 

0+ 

Search pattern that identify a field in a row (Date, description, 

amount, ...). This pattern is applied to the result of the 

filter_row_match pattern. 1 of each for 

every field 
filter_field_format 0+ Pattern for the formatting of the output of the matching field. 

filter_field_flags 0+ Flags used for the filter_field_match. 

Note: You need the same number of filter_field_match, filter_field_format, filter_field_flags parameters. 

 

Parameters for the search & replace method: 

filter_match 0+ Search pattern. 

1 of each for every rule, more rules are 

possible 
filter_format 0+ 

Format pattern for the output of the replaced 

text. 

filter_flags 0+ Flags used for the filter_field_match. 

Note: in the ini file you need the same number of filter_match, filter_format, filter_flags parameters. With the 

flag "format_no_copy" the text that is not part of the match will not be copied to the output, this is useful in 

case you want to delete part of the content. 

The syntax for the match, format and flags parameters follow the syntax of the boost regular expression 

engine (like the syntax of pearl regular expression). The description, some examples and tutorials can be 

found on the following page: Boost.RegEx. 

  

http://www.boost.org/
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Parameters for line sorting: 

The followings parameters are used to sort the lines, it is possible through regular expressions to identify the 

part of text used for sorting and the order of the sort. 

filter_sort_match 0/1 Search pattern. 

1 of each for every rule, more rules are 

possible 

filter_sort_format 0/1 
Format pattern for the output of the 

replaced text. 

filter_sort_flags 0/1 Flags used for the sorting match 

filter_sort_order 0/1 
Order for sorting "ascending" or 

"descending" 

  

Optional command line parameters 

-debug Overwrite the debug setting in the ini file to true, this is used only for debugging. 

-useoutfile Overwrite the useclipboard setting in the ini file to false, this is used only for debugging. 

-version Print the version of the file to the console. 

  

Regular expression syntax 

The syntax for the match, format and flags parameters follow the syntax of the boost regular expression 

engine (like the syntax of pearl regular expression).  

The documentation of Boost Regular Expression is found at the following page:  Boost.RegEx. 

If you  are new to regular expressions you can start from the following tutorial pages: 

Perl regular expressions 

Perl regular expressions tutorials 

Short tutorial Using regular expressions from the University of Virginia 

  

Requirements 

Banana Accounting 5.0.7 or above. 

Installation 

Download the file regex_filter.zip attached to this page. Unpack and copy the content to "{Program 

files}\Banana50\ExternalTools" folder. ( {Program files} is the path where the programs are installed, usually 

"C:\Program files") . Start Banana Accounting 5.0. Open an account and go to the menu "Account1" - "Import 

to the accounting", you should now see the pre-defined formats in the list. 

If you want to define a new format to import, copy an existing *.ini file and modify the tool's parameters. 

  

Pre-defined formats 

Version regextool: 1.0.9.0 (02.11.2011) 

Ini file Version Last Update Description 

http://www.boost.org/libs/regex
http://perldoc.perl.org/perlre.html
http://perldoc.perl.org/perlretut.html
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cbi-import 1.0 23.11.2010 CBI (TXT) 

china-construction-bank-csv.ini 1.1 16.12.2008 China Construction Bank (CSV) 

cs-import.ini 1.1 04.06.2009 Credit Suisse (CSV) 

hypovereinsbank-import.ini 1.4 24.03.2009 Hypovereinsbank (CSV) 

lukb-import.ini 1.2 24.07.2009 Luzerner Kantonalbank (CSV) 

mijnpostbank-import.ini 1.1 10.11.2010 Mijnpostbank (CSV) 

ofc-import.ini 1.1 16.12.2008 Open financial connectivity (OFC) 

ofx-import.ini 1.1 16.12.2008 Open Financial Exchange (OFX) 

v11-import.ini 1.2 16.12.2010 Postfinance ESR V11 (V11) 

pf-import.ini 1.2 02.11.2011 Postfinace xml account card (XML,TAR.GZ) 

pf-csv-import.ini 1.3 04.08.2011 Postfinace csv account card (CSV) 

qif-import.ini 1.2 16.12.2008 Quicken Interchange Format (QIF) 

rabobank-import.ini 1.0 11.11.2010 Rabobank (CSV) 

raif-import.init 1.1 15.11.2010 Raiffeinsen Bank (CSV) 

sgkb-import.ini 1.2 24.07.2009 St Gallen Kantonalbank (CSV) 

tkb-import.ini 1.2 24.07.2009 Thurgauer Kantonalbank (CSV,ZIP) 

ubs-import.ini 1.13 28.06.2011 UBS Bank (CSV) 

zkb-import.ini 1.3 30.03.2010 Zürcher Kantonalbank (CSV) 

  

Changelog 

2011-11-02 

Updated regextool to correct an error with some tgz files 

Updated postfinance xml to import account cost too 

2011-08-04 

Updated postfinance csv for quoted texts with lines breaks 

2011-06-28 

Updated ubs-import.ini for new field exchange rate 

2011-03-08 

Updated ubs-import.ini for charge backs with minus 

2010-06-16 

Version 1.0.8.0 

Updated zip library 

Updated ubs-import.ini for new csv format with details and totals 

2010-03-30 

Updated zkb-import.ini for new csv format 
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2010-02-18 

Improved decoding of csv files inf utf-8 format 

Updated zkb-import.ini for new csv format 

2009-11-17 

zuercherkantonalbank.ini version 1.1 

Updated zkb-import.ini for new csv format 

2009-08-24 

ubs-import.ini version 1.7 

2009-08-24 

ubs-import.ini version 1.6 

2009-06-04 

cs-import.ini version 1.1 

Updated cs-import.ini for new Credit Suisse csv format 

2009-04-06 

Version 1.0.6.0 

Added parameters filter-sort-xxx for sorting 

2009-01-14 

With Postfinance ESR V11 the cedit date is new imported as value's date instead as transaction's date. 

As transaction's date is now imported the processing date. 

2009-01-14 

Version 1.0.4.0 

New import for Credit Suisse csv. 

New parameter filter_reverse_order to output transactions in reverse order. 

2008-08-07 

Version 1.0.3.0 

New UBS format included in ubs-import.ini. 

2008-08-07 

Version 1.0.3.0 

It is now possible to import data directly from zip or tgz archives. See the description of parameter 

filter_archive_path. 

2008-03-26 

Added import for OFC (Open financial connectivity). 

2008-03-06 

Version: 1.0.2.0 

In case of erorr the text "error: {error description}" will be outputed to the clipboard or output file, this enable 

to report the error condition to the application 

2008-03-04 

Version: 1.0.1.0 

The filter for the Quicken Interchange Format can now import dates and amounts in European format too, 

before it was only in US format. 

 

2008-02-26 

Version: 1.0.0.0 

First release 

  

Examples 

CSV file without header 
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In this example the value are separated by a ';' and the amounts are idetified by a sign if a credit or debit. 

20080516;Telephone;-16.40; 

20080516;Salary;4000.00; 

'Filter parameters 

useclipboard=true 

filter_codepage= 

filter_header=Date\tDescription\tIncome\tExpenses\t 

' Parse the line of text 

filter_match=^([^;]*);([^;]*);(-)?([^;]*);?$ 

filter_format=$1\t$2\t(?3:$4)\t(?3$4)\r\n 

filter_flags=format_no_copy|match_not_dot_newline|format_all 

- (-)?([^;]*) : is the pattern that identify an amount 

- (?3:$4) : if the sign '-' is not found (3th group of the match pattern) output the group 4 

- (?3$4) : if the sign '-' is found (3th group of the match pattern) output the group 4 

V11 file 

In this example the value are found at a fix position, and the date has not a valid format. If the transaction is 

a credit or debit is given by the 3th char, '1 or 2'=credit and '5'=debit. We need more than one step to format 

the file. 

01201051010900000000000070100800003659100000110001546  

020007061107061207061300001004900000000000175                           

01201051010900000000000070102300003663200000230001546  

020007061307061407061500001002600000000000175                           

01201051010900000000000070102400003664100000110001546  

020007061307061407061500001002500000000000175                           

01201051010900000000000070105200003667800000110001546  

030007060907061107061200001000600000000000175                           

01201051010900000000000070105305003668500000110001546  

030007060907061107061200001006500000000000175                           

'Filter parameters 

filter_codepage= 

filter_header=Date\tDescription\tIncome\tExpenses\t 

'Parse a line in different groups 

filter_match=^..((1|2)|(5)).{9}(.{27})(.{10}).{10}.{6}.{6}(.{6}).{9}.{1}.{9}(.{4}) *$ 

filter_format=D#$6#\tS#$4#\t(?3A#$5#)\t(?2A#$5#)\r\n 

filter_flags=format_no_copy|match_not_dot_newline|format_all 

filter_match=D#(.{2})(.{2})(.{2})# 

filter_format=20$1$2$3 

filter_flags= 

filter_match=S#0*([^#]*?)# 

filter_format=$1 

filter_flags= 

filter_match=A#0*([^#]*?)(.{2})# 

filter_format=$1\.$2 

filter_flags= 

Quicken Interchange Format 
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In this example the data of a transaction are on multiple line. In this case the row&filed matching method is 

the best one. 

!Type:Bank 

D08/28/2000 

T-8.15 

N 

PCHECKCARD SUPERMARKET 

^ 

D08/28/2000 

T-8.25 

N 

PCHECKCARD PUNJAB RESTAURANT 

^ 

D08/28/2000 

T-17.17 

N 

PCHECKCARD SUPERMARKET  

... external tool basis configuration is omitted 

'Filter parameters 

useclipboard=true 

filter_codepage= 

filter_header=Date\tDoc\tDescription\tIncome\tExpenses 

'Match a transaction, every transaction is separated by the char '^' 

filter_row_match=(\A|^\^)[^\^]*(^\^|\Z) 

filter_row_flags= 

'Date 

filter_field_match=^D(.{2})/(.{2})/(.{4})$ 

filter_field_format=$3$1$2 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 

'Doc number 

filter_field_match=^N(.*)$ 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 

'Payee 

filter_field_match=^P(.*)$ 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

'Memo 

filter_field_match=^M(.*)$ 

filter_field_format=$1  

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 
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'Debit 

filter_field_match=^T([^-].*)$ 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 

'Credit 

filter_field_match=^T-(.*)$ 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\r\n 

filter_field_flags=format_no_copy 

Open finalcial Exchange (OFX) 

This is an example for parsing xml file, without the need of xsl. Even if this is not the best solution, it is 

possible to get the desired data. 

... 

<STMTTRN> 

<TRNTYPE> 

CREDIT 

</TRNTYPE> 

<DTPOSTED> 

20070315 

</DTPOSTED> 

<DTUSER> 

20070315 

</DTUSER> 

<TRNAMT> 

200.00 

</TRNAMT> 

<FITID> 

980315001 

</FITID> 

<NAME> 

DEPOSIT 

</NAME> 

<MEMO> 

Automatic deposit & loan 

</MEMO>                                                 

</STMTTRN> 

... 

 

'Filter parameters 

filter_codepage= 

filter_header=Date\tDoc\tDescription\tIncome\tExpenses 

filter_row_match=<STMTTRN>.*?</STMTTRN> 

filter_row_flags= 
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'Date 

filter_field_match=<DTPOSTED>[\r\n ]*([^ <\r\n]+)[\r\n ]*</DTPOSTED> 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 

'Doc number 

filter_field_match=<REFNUM>[\r\n ]*([^ <\r\n]+)[\r\n ]*</REFNUM> 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 

'Description  

filter_field_match=<NAME>[\r\n ]*([^<\r\n]+?)[\r\n ]*</NAME> 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 

'Credit 

filter_field_match=<TRNAMT>[\r\n ]*([^ \-<\r\n]+)[\r\n ]*</TRNAMT> 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline 

filter_field_match=\A 

filter_field_format=\t 

filter_field_flags=format_no_copy 

'Debit 

filter_field_match=<TRNAMT>[\r\n ]*-([^ \-<\r\n]+)[\r\n ]*</TRNAMT> 

filter_field_format=$1 

filter_field_flags=format_no_copy|match_not_dot_newline  

How to change from UPPER CASE (ABCD EFGH) to Title Case (Abcd Efgh) 

'Switch to title case 

filter_match=([^[:alnum:]]{1})([[:upper:]]{1})([[:upper:]]{1,})(?=[^[:alnum:]]{1}) 

filter_format=$1$2\L$3\E 

filter_flags=match_not_dot_newline|format_all 

 

How to sort lines with ascending dates 

' Sort lines 

' The first 8 characters contain the date: 20090321 ... 

filter_sort_match=^(.{8}) 

filter_sort_format=$1 

filter_sort_flags= 

filter_sort_order=ascending 

  



204 

B A N A N A  A C C O U N T I N G   

3.9.7 Clients/Suppliers Registers 

The Clients/Suppliers registers can be set up in two different ways: 

 with viewing of the Account cards on the Balance sheet 

 without viewing of the Account cards on the Balance sheet  

Clients/Suppliers registers with viewing of the Account cards on the Balance sheet: 

In both the Assets and the Liabilities, a group is being created that totals all the clients and another one that 

totals all the suppliers. 
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Under these two principal group headers, a list of client accounts and supplier accounts can be created. The 

"Gr" of the clients and suppliers register needs to be the same as the "Group" number set up in the Assets 

and the Liabilities. 
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When client or supplier transactions are being entered, the client or supplier account needs to be indicated.  

  

Clients/Suppliers registers without viewing of the Account cards on the Balance sheet: 

To avoid that all Account cards of clients and suppliers appear on the Balance sheet, the client/supplier 

registers can be set up using the Cost centers. In the Assets and Liabilities of the Chart of Accounts, clients 

and suppliers are recorded as an account and not as a group. 
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Cost center accounts for clients and suppliers are being created by using the "CC3" cost center. 
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In the accounting transactions, indicate the principal account (Clients/Suppliers) in debit or credit; in the 

"Cost center" view, the cost center account of the client or the supplier is being indicated. 
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3.9.8 Displaying expiry dates 

To display the expiry dates of the payable invoices and those receivable, the issued and received invoices 

need to be registered.   

The columns "Date Exp." and "Date Pay." have to already be displayed (Data menu, Set up fields 

command)   

 

 

   

Every time an invoice is being entered, enter the expiry date in the "Date Expiry" column; in the "Date 

Payment" column, the payment date needs to be entered.   
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In the event of wanting a display of unpaid or receivable invoices, activate the command Show expiry 

dates from the "Account2" menu.   

All the invoices that do not have a payment date will then be shown.   

 

 

   

3.9.9 Data security, data certification, retrieving a file 

Information about security, certification of the accounting and copying of the accounting files.  

   

3.9.9.1 Avoiding data loss 

The Banana accounting software automatically creates security copies (file name.ac2.bak). 

However, we strongly advise our users to create external backup copies in order to be able to resolve an 

eventual loss of data due to, for instance, a computer crash or another cause. 

There is free software on the market that allow the user to automatically create a backup for one's own data. 

  

  

  

3.9.9.2 Data recovery from the backup file 

When for one or another reason the user doesn't succeed to find the accounting file, one can retrieve the file 

from the backup copy that the program automatically executes.   

The user has to open the directory where the accounting file was present.   
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Open the file with the .bak extension. If it doesn't show in the directory, the user should, in the box "Files of 

type" in lower part of the window, select the option All files (*.*). 

 

 

 

Once opened, save the file (save as...)  
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Usually, the same name as the one of the lost file is attributed.   

 

 

 

3.9.9.3 Inserting a password 

The files can be protected with a password.  
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To insert the password, select the File and accounting properties command in the "File" menu; insert 

the password in the "Password" tab, entering it another time in the "Confirm new password" zone. In this tab, 

the user can insert a new password by entering it twice to confirm it.  

If, on the contrary, the user wishes to change an existing password, the old one has to be entered first before 

entering the new password.  

   

 

 

   

3.9.9.4 Installing Banana on a memory stick 

If you often need to change computer, it can be useful to install Banana directly on a memory stick and 

launch Banana directly from the memory stick.  

1. Install the program on the hard disk as usual  

2. Copy the directory "Programs/Banana50" on the memory stick 

3. To launch the program, double click on the "Banana50.exe" file. 

Warning: memory sticks can get lost and can easily be damaged.   

It is advised to make copies of your data.    

1. Create a folder on the memory stick and name it "Accounting" 

2. Save your accounting in the directory that you have created  

3. At regular intervals, make a copy of the "Accounting" directory on CD or on the hard disk.  

3.9.9.5 Making a security copy on a memory stick 

To make a security copy on the Memory Stick, open the file that is to be memorized; from the "File" menu, 

select the Save as command, and choose the unit that indicates the memory stick as destination.  

The copy can also be made by launching "Explorer" and by dragging the accounting file into the memory 

stick unit.  
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3.9.9.6 Protecting the rows 

Using the Protect rows command, from the Edit menu, the user activates row protection to avoid making 

any changes by mistake.  

The protected rows cannot be edited until, by using the Unprotect rows command, the protection is being 

removed.  

To put protection into effect:  

 Select the desired row(s) to protect 

 From the Edit menu, select the Protect rows command 

 Confirm the number of rows to be protected by clicking on OK. 

Protected rows have light grey row numbers. In order to edit them again, first remove the protection by the 

Unprotect rows command in the Edit menu.  

   

3.9.9.7 Security and data Certification 

In spite of its high degree of flexibility, Banana Accounting is a tool that is compliant with all international 

accounting rules: 

 It guarantees data integrity so that any alteration or processing can be immediately detected. The 

method used is protected by US Patent No. 7,020,640. 

 It allows files to be created with all the accounting data so that they can be opened, even years later, 

without using the program. 

Locking accounting transactions 

When accounting transactions have been checked, the "Lock Transaction" command can be activated 

(menu Conta2). 

 Insert the locking date (for example, the end of the month, the quarter or the year) 
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The entries are locked until the date stipulated and are assigned a series of counters. 

 

 

 LockNum: the progressive number that identifies the row 

 LockAmt: the cumulative transactions total, similar to the total at the end of the page, as required by 

some national regulations 

 LockProg: electronic signature (Hash MD5) that is the unique identification of all the transactions up 

to the point of entry. 

  

The program displays a lock report when the procedure has been completed.  
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Control code (Hash Md5) 

This is the main element of the certification, which takes the following into account: 

 The contents of the current entry 

 The contents of all the preceding transactions 

 The progressive number (LockNum) 

 The cumulative balance (LockAmt) 

The control number is different if the accounting data undergo even the slightest modification (a date or an 

amount is changed). If the control number remains the same, this means that the data are original and 

therefore have not been changed. 

The program automatically inserts the values in this section.  
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Recording the certification number 

Once the transactions in the period have been locked, it is enough to print the last certified row with the 

relevant certification number (LockProg) and to store this information in a safe place. If the certification 

number remains unchanged over time, it means that the data have not been modified. 

  

Related documents 

Some time ago, Banana.ch requested the auditing firm Ernst&Young to analyze this certification method and 

the firm approved and certified it as being in compliance with Swiss and German laws. 

 Document related to Swiss certification (PDF in German) 

 Document related to German certification (PDF in German) 

 

Long-term archiving 

The accounting data are always accessible even after long periods of time. 

Banana Accounting allows all the accounting data to be exported to Html e Xml. The generated file may be 

saved on a CD and accessed on any computer even after many years, even by persons who do not have the 

Banana Accounting software. 

Related documents 

 Archiving in Html and XML 

3.9.10 Executing tasks 

You can send command to Banana.  

http://www.ey.com/
http://www.banana.ch/accounting/files/ernstyoung_beurteilung_banana_ch.pdf
http://www.banana.ch/accounting/files/ernstyoung_beurteilung_banana_de.pdf
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3.9.10.1 Command line 

Command line  

You can import and export data.  

If a command fail, than a return code different than 0 is returned, and the error is inserted in the log file (only 

if the option -log_file was used).  

 

 The arguments need to be preceded by a minus "-" sign. If an argument is missing of the "-" sign, it 

is interpreted as the name of the file to open.  

 Include the whole argument within the delimiter "..." if the text include whitespace. 

 Running import as command in the command line save the accounting file on exit  

 

Example: open a file 

banana50.exe c:\temp\example.ac2 

banana50.exe "c:\temp\your example.ac2"  

Example: export to xml file 

banana50.exe -cmd=export "-cmd_file=c:\temp\my example.ac2"  

"-cmd_p1=c:\temp\my example.xml" -cmd_p2=xml  

-period_begin=2006-01-01 -period_end=2005-03-30  

The argument "-cmd=..." specifies the command to be executed. The other arguments specify the option for 

this command.  

   

Available commands 

You specify the command with the argument cmd=file_open  

Argument  Description  

cmd=  The command to execute  

file_open (cmd_p1=noshow)  

file_close (cmd_file)  

file_save (cmd_file)  

file_saveas (cmd_file, cmd_p1)  

file_show (cmd_file)  

get_tableinfo (cmd_file , cmd_table)  

get_cell (cmd_file, cmd_table, cmd_column, cmd_row)  

get_line (cmd_file, cmd_table, cmd_row)  

get_table (cmd_file, cmd_table)  1) 

get_lasterror  

set_language(cmd_p1)  

calc_all (cmd_file)  

calc_simple (cmd_file)  

deleterows (...) *)  

export (...)  

fileinfo (...)  

import (...) *)  

acc_accountcard (...)  

acc_externalreport (...)  

acc_vatreport (...)  
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1) Running import in the command line save the file on exit;  

   

*) If you use the commands "deleterows" and "import" directly from a command line the file is automatically 

saved on exit  

1) Since Banana 6.0.6 

   

List of arguments  

Command  Argument  Description  

From command line  cmd_exit=1  The program should exit and terminate 

Note if you use the command import= then the file that 

has been opened is automatically saved when the 

program terminate.  

For all commands  cmd_file=  the file to use or open  

cmd_pw=  password to open the file  

cmd_names=  A - Field name in XML (default on)  

a - Field name in original language  

log_file=  set the log file name for writing messages (if no file name 

no log)  

deletelines  cmd_p1=  start of line to delete (number)  

cmd_p2=  how many lines to delete (if not present = 1)  

cmd_table=  The name of table  

         

set_language  cmd_p1=  The two letter ISO639 language code (de, fr, en, it)  

         

file_open  cmd_p1=  noshow - do not show the file  

         

file_saveas  cmd_p1=  file name of saved file  

         

get_tableinfo  cmd_table=  The name of the table to get info  

         

get_cell  cmd_table=  The name of the table  

cmd_row=  The number of the row, or an expression like 

"Account=1000:3" (In this ex. the third row where the field 

Account is equal to 1000 is used)  

cmd_column=  The name of the column  

cmd_op=  A - Format value (default on)  
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get_line  cmd_table=  The name of the table  

cmd_row=  The number of the row, or an expression like 

"Account=1000:3" (In this ex. the third row where the field 

Account is equal to 1000 is used)  

cmd_op=  A - Format value (default on)  

get_table 1)  cmd_table=  The name of the table  

cmd_p2=  Type: html, excel, xml, txt (defalut html)  

export_op_html=  Same as for cmd export 

export_op_xml= Same as for cmd export 

export  export_use_param  Instead of the default parameters use the last saved 

parameters (set with the dialog) and then applies the 

specified options with the other arguments  

cmd_p1=  file name of the export file  

cmd_p2=  Type: html, excel, xml, txt 1) 

cmd_table=  The name of table to export (only the table is exported)  

export_include=  Options:  

Upper case(A) = on; Lower Case(a) = off  

A - Recheck accounting (default on)  

B - Include statistics table (default on)  

C - Include transaction table (default on)  

D - Include account table (default on)  

E - Include category table (default on)  

F - Include total table (default on)  

G - Include Exchange rate table (default on)  

H - Inclue Vat code table and vat report (default on)  

I - Include Period Accounts (default on)  

L - Include Period VAT (default on)  

M - Create periods for the whole year (default off)  

N - Create accounts card  

export_include_ma=  number of months for accounts period, for option I, 

(default 1)  

-1 for daily  

export_include_mv=  number of months VAT period, for option L (default 3)  

export_include_mm=  max numbers of periods (default 36)  

export_op_html=  Options for html  

A - Use style sheet  

B - Use predefined style sheet (default on)  

C - Include style shett within html file (default on)  

D - Export visible fields only (default on)  

E - Table with borders (default on)  

F - Columns with headers (default on)  
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G - Preserve page breaks within the table (default on)  

H – Export as data (default off)  1) 

export_op_excel=  Options for Excel export  

A - Define cell name (default on)  

B - Define table name (default on)  

C - Use Xml names (default on)  

D - Protect tables (default on)  

export_op_xml=  Upper case(A) = on; Lower Case(a) = off  

A - Visible field only (default off)  

B - Include view list (default off)  

C – Export as data (default off) 1) 

period_all  period All  

period_begin=  Begin date (yyyy-mm-dd)  

period_end=  period End date (yyyy-mm-dd)  

vat_use_param=  Instead of the default parameters use the last saved 

parameters (set with the dialog) and then applies the 

options specified with vat_op  

vat_op=  A - Include transactions  

B - Include total account  

C - Include total codes  

D - Include total percentage  

E - Use own group schema  

F - Only code specified  

G - Only group specified  

vat_sort=  sort field  

vat_text=  single code or groups (to use with -vat_op F and G)  

      

fileinfo  cmd_op=  A - Recalculate all (default off)  

import  cmd_p1=  File name of the file to import. Data have to be separated 

by tabulator, and the first row has to contain the name of 

the fields.  

cmd_p2=  Insert al line number (0=Append to end)  

cmd_op=  A - Complete imported raws  

cmd_table=  The name of table where to insert the data 

(Accounts, Transactions, ...)  

      

acc_accountcard  cmd_p1=  account number  

cmd_p2=  field name for sorting  

period_all  period All (default)  
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period_begin=  Begin date (yyyy-mm-dd)  

period_end=  period End date (yyyy-mm-dd)  

acc_externalreport  cmd_p1=  file name of the report  

cmd_p2=  column name for grouping  

cmd_op=  Upper case(A) = on; Lower Case(a) = off  

A - Include account with balance = 0  

B - Include account with no transactions  

C - Include totals only  

D - Notify if an account is without a group  

      

acc_vatreport  period_all  period All (default)  

period_begin=  Begin date (yyyy-mm-dd)  

period_end=  period End date (yyyy-mm-dd)  

vat_use_param=  use parameters from existing dialog + specified options 

like vat_op  

vat_op=  Vat options  

Upper case(A) = on; Lower Case(a) = off  

A - Include transactions  

B - Include total account  

C - Include total codes  

D - Include total percentage  

E - Use own group schema  

F - Only code specified  

G - Only group specified  

H - Not used groups  

vat_sort=  sort field  

vat_text=  single code or groups (to use with -vat_op F and G)  

      

  

1) Since Banana 6.0.6 

Attachment Size 

Attachment Size 

CommandLineExample.zip  29.47 KB 

3.9.10.2 DDE 

DDE interface 

 

Through a DDE mechanism it is possible to:  
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 Send command to Banana Accounting  

Retrieve information form Banana Accounting  

The best way to learn how to use the DDE interface is to look at the example included.  

To send command to the software use  

Initiate the DDE sequence  

Service name: "Banana50"  

Topic name: "CONNECT"  

   

DDEExecute channelNumber, Request  

   

Request can be any command indicated command line  

   

cmd=get_cell  

Example for Excel  

   

=Banana50|CONNECT!'cmd=get_cell cmd_file=company.ac2 cmd_table=Accounts cmd_row=3 

cmd_column=Description'  

   

=Banana50|CONNECT!'cmd=get_cell cmd_file=company.ac2 cmd_table=Accounts cmd_row=account=1000 

cmd_column=Description'  

   

DDE Compatibility with Banana version 4:  

The Service name "BANWIN" is still compatible with version 5  

The topic name "DATA" is not compatible, change it to "CONNECT"  

Request formatted for Banana 4 are converted in command for Banana5  

Attachment Size 

Attachment Size 

DDE examples.zip  96.68 KB 

3.9.11 Segments 

The segments represent a kind of cost center. They distinguish themselves from the traditional Banana 

Accounting cost centers by the following characteristics: 

 They show the balances of an account or of a sub-account 

 They can refer to several levels of an account. 

 In the Transactions table, they can directly be inserted in the Debit or Credit account. It is therefore 

not necessary to enter them in separate columns. 

 The reports of the segments are automatically being calculated by the program and can by 

distinguished by period. 

Segments per project 
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Segments per branch office  
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3.9.11.1 Structure 

The segments have to be configured in the Accounts table at the end of the chart of accounts. They can 

have several levels, those of the first level being preceded by ":", those of the second level being preceded 

by "::",those of the third level being preceded by ":::" and so forth. There are no limits to the levels. 

For the configuration, proceed as follows:  

 Insert the title "Segments" in the Description column. 

 Insert an asterisk in the Section column. 

 Insert the description of the first-level segments, and in the Account column, insert ":" 

 List the segments of the first level, entering an identification code for each one of them in the 

Account column, preceded by ":". 
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 Proceed by entering the segments of the second level (and, if necessary, those of the third level), in 

the same way as those of the first level, with the only difference that the segment codes need to be 

preceded by "::" or by ":::", depending on their level. 

  

 

  

  

3.9.11.2 Transactions 

The segments are being entered in the Transactions table. Each segment is preceded by the colon, or by the 

minus sign (-), in case the option Use the minus sign (-) as segments separator has been activated 

in the File and Accounting properties (File menu). 

The use of the colon “:” in the segments is advised when there are account codes with a minus sign in the 

Chart of Accounts.  

When a segment that belongs to more than one level needs to be entered, the segment of the first level 

needs to be entered right after the main account; then, continue with the code of the second level. 
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3.9.11.3 Reports 

The reports of the segments can be automatically obtained with the Enhanced balance sheet by groups 

command or by the Accounting reports command in the "Subdivision" tab. 

 

Segments per project 
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Segments per branch office 

 

  

3.9.12 Information for developers 

All the information about developing applications not included in Banana accounting is being presented:  

 Developers kit (zip, 2.6 MB) 

Includes information and examples of the following: 

Start-up with commands, DDE, importation, exportation, Excel links, XSLT use, recovery and 

reprocessing of data from the XML format.  

  

More information for advanced features.  

3.10 Print-outs 

Print-outs 

http://www.banana.ch/accounting/files/developers.zip
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3.10.1 Page setup 

Using the Page setup command from the File menu, a window will pop up where various printing options 

for the active table and the current view can be chosen (for each table it is necessary to repeat these steps). 

Before printing, it is advisable to preview the page to see whether the details input for the page setup are 

correct.  

 

   

Header left  

This is where the title for the current view is shown. The title can be edited to appear at the top left of the 

printed page.  

  

Header right  

It is possible to insert a different text that will be printed at the top right-hand side of the page.  

  

Margins  

It is possible to input the page margins here. Measurements are in centimeters.  

  

Include in print 

File Header  

This will be the text inserted in the File and Accounting properties found in the File menu.  

  

Table Header  

This is the text input in the Page setup window in the File menu (Header left and right).  

  

Auto text  
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This is the text automatically attributed to the table by the program. This text cannot be edited by the user. 

For example, if the cash account card is being printed, then “Account Card: CASH” will be printed.  

  

Column headers  

These are the headers for the various table columns.  

  

Large font  

The program prints the headers using a slightly larger font 

  

Page break 

When activated, this option maintains the inserted page breaks; if not, they will be ignored, even if they are 

present.    

  

Page numbers  

Activate this option to request that the pages be numbered.  

  

Print time  

Activate this option to include the hour when the page was printed.  

  

Print date  

Activate this option to include the date when the page was printed.   

  

Row number  

Activate this option if a progressive number is to be given to each row.  

  

Grid  

The grid can be printed just as it is viewed on screen.  

 

Layout 

Zoom %  

This allows the increase or decrease, on a percentage basis, of the size of the font to be printed.  

  

Shrink to page width  

If some columns exceed the width of the page, the program reduces (reduces the zoom) the printing so that 

all the columns will be printed correctly on the page. 

 

As on screen   

If this option is activated, the width of the columns will correspond to the widht shown on the screen. If not, 

the width will automatically be adapted to the content of the column.   

  

Print landscape  

To print in landscape format which makes the page read horizontal.  

3.10.2 Balances by period 

To display the balances by period in the Accounts/Categories table, activate the Accounting reports 

command in the Cash1/Simple1/Account1 menu and in the Period tab, define the desired period. 
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The program shows, on the "Accounts/Categories" table, Balances view, the balances of the indicated 

period. For a print-out, activate the Print command from the "File" menu.  
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3.10.3 Printing the journal 

In Banana accounting, the journal corresponds to the Transactions table. The user can print the complete 

journal or only a part, by selecting the rows one desires to print.  

In order to personalize the printing of the journal, the layout and the column headers can be changed (Data 

menu, Set up fields command); also, in the page setup (File menu), several options to include in the printing 

can be chosen. 

 

 

There are different ways to print: 

 Put yourself in the Transactions table and click on the printing icon;  

 Put yourself in the Transactions table and from the File menu, click on Print; 

 From the Account1 menu, click on Journal by period: in this way one can choose to print all or only a 

designated period.  
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In the "Sort Fields" tab, one can choose according to which type of date to sort and print the journal.   

 

 

 

3.10.4 Printing account cards 

To display an Account card, you have to double click on the account number.   

To display several account cards, proceed as follows:  

From the "Account1" menu, Account cards command, select the Account cards that need to be 

visualized, by clicking on the account and going to the next ones while always pressings on the Ctrl key.  In 

case all the Account cards need to be visualized, click on the "Select all" button.  
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There are several ways to print the Accounts cards. Generally speaking, if only a few account cards need to 

be printed, these can be opened by double clicking on the account number in the Accounts or Transactions 

table, and start the "Print" command in the File menu or from the print icon. 

When more (or all) account cards are to be printed, the "Account cards" command from the Account1 menu 

needs to be activated. 

In the "Accounts/Categories" tab, there is the possibility to only select the accounts (and/or categories), only 

the cost centers, or to select all. 
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In the "Period" tab, the option "All" can be activated, which means that the account cards will have all the 

entered accounting transactions, or, by activating "Period selected" and entering a start and an end date, the 

account cards with the transactions of the indicated period can be obtained. 
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In the "Options" tab, when "One account per page" is activated, the program visualizes one account per 

page for printing; if on the contrary this function remains inactive, the account cards will be visualized and 

printed one after another without page break. 
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In the "Sort fields" tab, the user indicates in which order the transactions will be visualized in the account 

cards.  
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In the following image, examples of some account cards are visualized, before printing them. 
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Once the account cards appear on the screen, the user only needs to start printing. Explanations on the 

contents of the 'contra account' column. 

3.10.5 Enhanced statement 

Enhanced statement Cash book 

Enhanced statement Simple accounting 
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3.10.6 Balance Sheet at year's end 

The Enhanced Balance Sheet presents all the Assets', Liabilities', Expenses' and Income's accounts, 

indicating the profit or loss of the accounting period. The grouping of the accounts is done according to the 

contents of the BClass column. In order to obtain it, activate the Enhanced balance sheet command in 

the Account1 menu.  

Several options for the enhanced and predefined printout of the Balance sheet and the Profit & Loss 

Statement can be activated in the window that appears.  

   

 

   

Assets and Liabilities  
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Expenses and Income  
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3.10.7 External Accounting Report 

The External Accounting Report allows the user to regroup an already existing Chart of Accounts with 

groupings according to different set ups and requirements, without having to adjust the Chart of Accounts of 

the main accounting.  

To calculate the external accounting report, the user needs to:  

 Create an External accounting report file with the desired accounts and groupings (File, New, Other) 

 

 Open his own accounting file and in the Accounts table, link one of the following columns as the 

grouping: BClass, Gr, Gr1, Gr2 (should the preselected column not be visible, use the Set up fields 

command in the Data menu). 
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 From the accounting file, Account1 menu, select the External accounting report command 
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 In the window that appears, select the External accounting report option and with the 

"Browse" button, select the External accounting report file that has been created seperately 

 In the zone indicated as Grouping column, indicate the column used as link in the accounting file (in 

our example GR1) 

 Activate the desired options of the Subdivision, Period and Favorites tab 

 To obtain the Accounting report, click on "OK" 

 

Example of External Accounting Report  

 

The External Accounting can be saved and printed. 
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3.10.8 Balance by classes 

The Balance by classes allows the user to rapidly calculate and view all the accounts according to the 

BClass, with their groups and the Totals table descriptions. Sub-groups totals and the accounts with zero 

balance will not be shown. 

When the Chart of Accounts has been set up with several sub-groups, the Balance by classes facilitates the 

view of the accounts.  

Example of a Chart of Accounts with Assets grouped into several sub-groups:  

 

   

In order to obtain the Balance by Classes, activate the Balance sheet by classes command in the 

Account1 menu.  

The program will present an Accounting Report where the Balance Sheet and the Profit & Loss 

Statement are grouped by classes.  
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In order to print the Balance by classes after having visualized it, you can launch the printing directly by 

clicking on the printing icon at the toolbar, or, from the "File" menu, activate the Print command.  

3.10.9 Enhanced balance sheet by groups 

A new command (Account1\Enhanced balance sheet by groups) gives the possibility to obtain considerably 

improved printouts. 

A window with different tabs appears; they allow the user to configurate the printing parameters: 

 Include groups and subgroups in the printout, as in the chart of accounts.  

 Exclude groups or accounts (for instance, only the total of the group and not the accounts of which 

the total is composed). 

 Click on "Sections" to select which items to include in the printout (Assets, Liabilities, Expenses, 

Revenue, Registers, Cost centres)  

 Select the columns to be printed 

 Indicate if only the groups need to be printed  

 Subdivisions by period (day, month, quarter, semester, year)  

 Subdivisions by segment 

 Indicate if only a determined period needs to be considered (f.i., the months of the first semester)  

 Applicate different printing styles 

 Change the print characteristics (colors, background, alignment) 

 Indicate if the page numbers and the printing date need to be indicated 

 Save the printing configurations under a new name (favorites), so that it can always be reprinted 

when needed. 

The Balance by Classes, which can be obtained through the Accounting Reports command, can be set up 

with different printing parameters. 

  

Example of a printout with an Enhanced balance sheet by groups 
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3.10.9.1 Base 

In this section are entered all the Balance sheet heathers with different printing options. 
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Page 

The rows Header 1, Header 2, Header 3, Header 4 are destined for the headers of the print-outs. 

Print cover page / Print date / Print page numbers 

By activating these options, the cover page, the date and the page numbers will be printed. 

Column header (Balance/Profit and Loss) 

Enter the beginning date and the end date of the current year and the beginning date and the end date of the 

previous year. 

Show columns 

When these options are selected, the account numbers, percentages, previous year balances, the budget 

and foreign currency will be shown. 

Show rows 

When these options are selected, the accounts, the accounts with zero balance, the accounts with 

transactions and the groups with zero balance will be shown. 
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3.10.9.2 Sections 

In this section, different sections can be included in - or excluded from - the display or the printout of the 

Balance sheets by groups.  

 
Print sections 

In the box, all the sections of the chart of accounts that have been marked with the provided encoding are 

being shown. 

Start on new page 

If the user wants a section of the Balance sheet to be printed on a new page, click on the section and check 

the box. 

Print section title 

Allows the user to print the title of the section. 

Alternate text for section title 

To change the text of the different sections (for example, revenue with income), just select the desired title 

and enter the alternate text in the box. 

For those who use a chart of accounts with the lists of expenses and revenue mixed, the report can be 

personalized with the following functions: 

 Group for % calculation 

 Show group up to level 

 Row options 
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By clicking on the main groups (Assets, Liabilities, Expenses, Revenue, etc) the following options are being 

activated: 

Group for % calculation 

The percentages of the totals are being calculated according to the selected group or subgroup. If no option 

is being selected, the percentages are calculated according to the total of the main groups. 

Show group up to level 

By selecting a level from the list, the data will be displayed up to the chosen level. 

Row options 

By clicking on this option, a window appears in which different configurations can be selected related to the 

rows. 

Text parameters 

The parameters that have been chosen for the section can also be introduced in the form of codes to be 

entered in this area. It is also possible to enter parameters that have not been considered in the above 

mentioned options. 

3.10.9.2.1 Sections column in the accounting plan 

In order to create automatically a Balance Sheet by groups, the chart of accounts needs to be configured 

with special codes that are to be entered in the Section column. 

The encoding is the following: 

For more details please visit the Sections logic page 

* Title 1 To enter for the main headers 

** Title 2 To enter for the secondary headers 

1 Assets To enter in the title row Assets 

2 Liabilities To enter in the title row Liabilities 

3 Expenses To enter in the title row Expenses 

4 Revenue To enter in the title row Revenue 

01 Client's Register To enter in the title row Client's Register 

02 
Supplier's 

Register 
To enter in the title row Supplier's Register 

03 Cost Centers To enter in the title row Cost Centers 

04 Profit Centers To enter in the title row Profit Centers 

#* Notes To enter in the title row Notes 

#X Hidden data 
To enter in the row from whereon the data have to be 

hidden 

 Enter a * on the same row as the title Balance Sheet  

 Enter 1 on the same row as the title Assets 

 Enter 2 on the same row as the title Liabilities 
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 Enter a * on the same row as the title Profit/Loss Statement  

 Enter 3 on the same row as the title Expenses 

 Enter 4 on the same row as the title Revenue (Income). 

Attention: in case a chart of accounts with Expenses and Revenue mixed (with the calculation of the 

Gross Profit) is being used, insert a  "*" on the title row "Profit/Loss Statement" and only the number 4 on the 

row preceding the row containing the title "Expenses" or "Revenue". 
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For the clients/suppliers register a new section is being defined, by entering an asterisk as usual. 

 Enter 01 on the same row as the title Clients register 

 Enter 02 on the same row as the title Suppliers register 

The amounts will be shown in the same way as for the Assets and the Liabilities. 

This encoding is also valid when the clients and suppliers are configured as cost centers. 

Example in case there is a clients/suppliers register in the chart of accounts. 
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In case there are cost or profit centers configured, enter the following elements 

 An asterisk for the section change 

 03 on the same row as the title Cost center 

 03 on the same row as the title Profit center 

The amounts will be shown as positive (in black) like the expenses and in red like the revenue. 
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3.10.9.2.2 The Sections logic 

The Sections different encoding determines how the printout will come out. 

Each section is printed as a separate table. 

The directories 

 

 * Title 1 creates a level 1 directory.  

It can contain level 2 sections or directories.  

It is useful to group sections that need to be printed together, such as the Balance sheet, which 

contains Assets and Liabilities.  

 ** Title 2 creates a level 2 directory. 

The Base sections 

The Section number or code determines 

 how the amounts are printed. 

The amounts can be visualized just like in the Balance sheet or inverted.  

If the Credit amounts (in negative) are inverted, they will be visualized in positive, and the positive 

amounts will be visualized in negative.  

 which amount columns will be used 

The Balance column or the Period Movement column are used.  

The Balance column indicates the account balance at a specific date (balance at Jun 30th). 
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The Total Period Movement column indicates the movement amount on the indicated period.  

It is used for the Profit and Loss Statement and indicates the costs or the revenues for a certain 

period.  

Here is the explanation of the different sections 

 1 Assets (amounts as in the accounting plan, balance column) 

 2 Liabilities (inverted amounts, balance column)  

 3 Costs (amounts as in the accounting plan, total movement column)  

 4 Revenues (inverted amounts, total movement column) 

This section can be also used alone and it can include both costs and revenues (Conto economico a 

scalare). In this case revenues would be displayed in positive and costs in negative.  

These sections must be unique. Therefore there can only be one 1 Assets, or one 2 Liabilities section. For 

other sections, like clients/suppliers register or cost center similar sections can be used. 

Derivatives Sections 

 

Those are Sections that are similar to the Base Sections 

 01 Similar to Assets (amounts as in the accounting plan, balance column) 

It is used for the clients register. 

 02 Similar to Liabilities (inverted amounts, balance column)  

It is used for the suppliers register.  

 03 Similar to Costs (amounts as in the accounting plan, total movement column)  

It is used for Cost Centers. 

 04 Similar to Revenues (inverted amounts, total movement column) 

It is used for Profit Centers. 

Other Sections 

 

There are other kinds of sections 

 # Indicates a Notes Section (it prints only the Description column) 

It is used for the Balance sheet attachments 

 #X Hidden Section. This section is not included in the sections selection and it is not printed.  

It is used to indicate parts not to be printed.  

  

Columns width in printout 

 

The columns width is automatically set by the program. 

Sections 1, 2, 01, 02 have the same width as the columns. 

Sections 3, 4, 03, 04 have the same width as the columns. 
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3.10.9.2.3 Row Options 

When the mouse is on a section row, you can access the rows options, which allow to set different printing 

options for that row, account or group. 

 

 

  

Attention: If you make big changes in your accounting plan, it is advisable to also verify the rows printing 

options. 

3.10.9.3 Subdivision 

From this section you can select the period subdivision (for ex. for the first semester you can have a 

subdivision by quarter), or you can create periods for a unique segment or for different segments. 
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None 

The entire period is being shown. 

Subdivision by period 

This function makes it possible to display the dates of the selected period per day, month, bi-monthly, per 

quarter, per 4 months, per semester or per year. The selected period will be shown in the column headers. 

Only segment 

The data related to the selected segment are being shown. 

Create periods for the whole year 

When the accounting period is not the same as the solar year, but when the user still wants to see all 

months, this function needs to be activated. 

Totals column 

This function creates a Totals column for the selected periods in the Profit / Loss Statement and in the Totals 

view of the Accounting reports command (Account1 menu). 

Max number of divisions 

The default maximum number of periods is 36. In particular cases, if the user would want to obtain special 

and very detailed statistics over a long time span, this value can be changed manually. A very high 

maximum number of periods can slow down the program. 

Subdivision by segment 

The data related to the selected segment are being shown. In the column headers the selected segment is 

present. 

Totals column 

When this option is being activated, the totals for the selected segment will be obtained 

3.10.9.4 Period 

The Period sections is the same as in the Enhanced Balance sheet. It allows the user to choose a period. 
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All 

By activating this option, the balance sheet for the entire accounting period is being calculated and shown. 

Period selected 

This option allows the user to obtain the balance sheet for a determined period, by inserting the start and the 

end date. When a specified period is inserted, the field of the current year, in the Base tab, is automatically 

updated. 

  

3.10.9.5 Style 

The Style sections allows the user to choose between several preset styles and to change some options 

such as the font, the color, ... and to personalize the Enhanced Balance sheet by groups presentation. 



261 

B A N A N A  A C C O U N T I N G  

 

 

Use style 

There are different models of the Enhanced balance sheet provided. By selecting one, the user can obtain 

the Enhanced balance sheet of his choice. 

Style property 

For each style, the color of the fonts and the backgrounds can be defined. 

Value / Change... / Default 

These functions allow the user to change style or to restore the default style. 

Ignore line formatting 

If this function is activated, the formatting will not be maintained. 

Include accounts and groups excluded 

If this function is activated, also the excluded accounts and groups will be shown. 

Print error messages 

If this function is activated, the error messages will be printed. 

Zoom 

The display of the Balance sheet can be maximized or minimized. 

Page orientation 

This function makes it possible to change the orientation of the page (portrait, landscape). 

3.10.9.6 Texts 

This tab is used to alter the texts that the program uses as default headings for print-outs.  
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Here is how to proceed: 

 Select the text you wish to change 

 Type the new text in the "Value" box 

 Click on the "Modify" button 

 

With the "Value=Key" button, the original text is restored. 

  

3.10.9.7 Margins 

In this section the margins for the printout can be set. 
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Begin to print accounts 

Enter or alter the print margins in this field. 

Margins 

Enter the space between the page margins and the header or the footer. 

  

3.10.9.8 Favorites 

The functions of this tab allow the user to save models of different reports, so that manually changing and 

selecting options for each print-out is no longer needed. 
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Use selected 

Allows the user to select the favorite that is to be used. 

Set as default 

Makes it possible to define the default favorite (the report model that will be charged during the next opening 

of the dialogue). 

Rename 

Allows the user to rename the favorite. 

Duplicate 

With this button, the user can duplicate a report model to have the possibility to modify the desired 

configurations and create a new report model: 

 Click on "Duplicate" 

 Enter the name of the new report in the window and confirm with OK  

 Select the options of your choice from the different tabs  

 With the preview, the selected configurations for the report are automatically being saved.  

New 

Allows the user to create a new report model. 

Delete 

Allows the user to delete an existing report model. 
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3.10.9.8.1 Creating Favorites 

The Favorites section alows the user to obtain different Enhanced Balance sheets by groups, of which each 

one has itsw own configurations. When needed, the desired Balance sheet can be obtained, without 

changing the display or printing configurations.  

The options and commands of the Favorites section are being explained in detail in the Favorites lesson.  

  

Example:  

One can choose the configurations to obtain a balance sheet for the audit, while another one can be 

destined for inner office use with a period subdivision by quarter.   

How to proceed for the Audit favorite: 

 From the Account1 menu, Enhanced balance sheet by groups command, Favorite section, select 

Favorite and rename by means of the Rename button; enter the name "Audit"  

 From the different sections, choose the desired options 

 In order to save the Audit favorite, proceed with the Preview 
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To create the Quarter favorite: 

 From the Account1 menu, Enhanced balance sheet by groups command, Favorite section, click on 

the New button and enter the name Quarter 

 In the Subdivision section, activate "Subdivision by period" and "3 Months (Quarter)" 

 In order to save the Quarter favorite, proceed with the Preview 
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When there is a list of Favorites, distinguished by name, it is always the Default Favorite that is being 

displayed, unless, by means of a double click or the "Use selected" button, a favorite different from the 

default favorite has been activated.  

Warning: before modifying the configurations of a favorite, make sure that you are modifying those of the 

favorite of your choice:  

 

 

 The used Favorite is being displayed in the header of the window "Enhanced balance sheet by 

groups". 

 The Default Favorite is being shown with an asterisk " * ". 

 To go from one Favorite to another, select the favorite you want to use, and click on "Use selected" 

or "Set as default", if you wish to change the Default Favorite. 
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3.10.10 Printouts saved in different formats 

 

 

All the printouts of the various accounting documents can be saved in PDF, HTML, MS Excel and copied to 

the Clipboard, allowing the user to also access them many years later. 

  

3.10.11 Enhanced Balance Sheet with Period subdivision  

In order to display a Balance sheet with a subdivision of a selected period, the Enhanced Balance Sheet by 

groups command from the Account1 menu should be activated: 

 In the Period section, enter the desired period (f.i. 4 quarter) 

 In the Subdivision section, enter the desired subdivision type for the selected period (f.i. monthly, 

quarterly... ) 

Note: 

In the Balance Sheet, the program displays the balances at the end of the period.   

In the Profit/Loss Statement, the program displays the transactions of the period. 
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Balance sheet / 4. Quarter 

 
Conto economico / 4. Trimestre 
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3.10.12 End-of-year PDF printouts 

A new command (File menu, Export file to Pdf) allows the user to create a PDF file, containing all the 

necessary printouts for the accounting data archives: 

 Balance sheet and Profit/Loss statement 

 Accounts, Transactions, VAT Codes and Totals tables 

 VAT Reports 

 Account cards 

The file is created with a content's table which facilitates easy access to the different printouts. 

If this file is being saved on a non-rewritable CD (being kept together with the accounting documents), the 

requirements of the law are being met concerning the archiving of the accounting data. 
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3.11 What to do if you get an error message 

If the program shows error messages: 

 Update your software to the latest available version, by downloading it at the following page: 

http://www.banana.ch/cms/en/download_en 

 Check that your opening balances are correct 

 Recalculate your accounting file by pressing Shift+F9 

 If you have a multi-currency accounting file, check that the exchange rate differences have been 

calculated  

 You can look for the exchange rate difference transactions with the "Search for transaction 

differences" command from the Account1 menu.  

 


